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Copyright © 2000 by Tekla Corporation

All rights reserved. No part of the contents of these Training Notes may be reproduced or transmitted in any form or
by any means without the written permission of Tekla Corporation or Computers & Engineering.

Limitation of warranty and liability

NOTICE: THE FOLLOWING LIMITED WARRANTIES APPLY ONLY TO THE CIRCUMSTANCES SET FORTH HEREIN.
THERE ARE NO OTHER WARRANTIES,WHETHER ORAL OR WRITTEN, EXPRESS OR IMPLIED, INCLUDING BUT
NOT LIMITED TO ANY WARRANTY OF MERCHANTABILITY OR OF FITNESS FOR A PARTICULAR PURPOSE AND
ANY WARRANTY AGAINST INFRINGEMENT OF ANY PATENT TRADEMARK OR COPYRIGHT EXCEPT AS
OTHERWISE HEREIN PROVIDED.

Tekla Corporation (�Tekla�) warrants that its software products will perform on computer configurations approved by Tekla as
described in this manual and other Tekla's documentation accompanying the relevant software so long as they are installed,
implemented and operated in accordance therewith.

Furthermore Tekla warrants that the instructions and information contained in this manual will, when applied by adequately
qualified operators (or developers as the case may be), or where appropriate, qualified civil/structural engineers, result in the
software performing substantially as described in the documentation accompanying the software.

This warranty sets out Tekla�s entire liability to the customer, its employees, servants, agents and sub-contractors, including
but not limited to, its liability in contract or tort and including any liability for the actions and omissions of Tekla�s employees,
servants, agents and sub-contractors. Tekla does not exclude or limit the application of any warranty or condition implied by
the relevant legislation which may not be excluded, restricted or modified by agreement.

Tekla does not give any warranty in respect of third party software except that Tekla�s software is, to the extent referred to in
this manual and other documentation accompanying the software product, compatible with third party software products.
Neither does this warranty extend to any modifications or enhancements of Tekla�s software products made by other than
Tekla. The results and performance of the software products due to modifications or enhancements including direct
interfacing with Tekla�s software shall be the sole responsibility of the person making such modifications or enhancements.
The Customer is not entitled to make any modification or alteration in or to the software without the prior written consent of
Tekla.

Tekla�s sole responsibility under this warranty shall be limited to correcting errors in or replacing Tekla�s software so that it
performs substantially as specified in the documentation for such software products or correcting such errors in this manual
that prevent the use of software.

Tekla do not warrant that the software products will:

1. Be suitable for use as intended by the customer

2. Operate uninterrupted or error-free

3. Interact with application packages other than those specified in the accompanying documentation and/this
manual

4.    Operate with hardware or hardware configurations other than those approved by Tekla.
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Except as expressly set out in this manual Tekla shall not be liable for:

1. Misuse or negligent use and/or use by unqualified persons of the software products including failure to use the
software products in accordance with accompanying manuals.

2.   Loss or damage arising from any errors that may be contained in the text of this manual or other documentation
accompanying the relevant software product, or of the operation of the software.

3.   Indirect special or consequential damages (including loss of profits revenue or contracts) whether based on
contract tort or any other legal theory. The foregoing limitation of liability shall not apply in the event that the
software product is determined by a court of competent jurisdiction to be defective and to have directly caused
bodily injury, death, or property damage provided that, to the extent permitted by law, Tekla�s liability shall in no
event and for any damage exceed the license fee for the specific software that caused such damage.

This warranty shall be null and void and of no effect unless and until the customer shall advise Tekla in writing of any and all
claims based in whole or in part on warranty within ten days of the customer becoming aware of such claims. This warranty
shall be interpreted pursuant to the laws of Finland.

Trademarks

Windows Nt is a trademark of Microsoft Corporation.
Xsteel is a trademark of Tekla Corporation
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X-STEEL
TEKLA

SORUMLULUK

X-Steel�in Tüm haklarõ saklõdõr. Bu eğitim notlarõ içindeki bölümlerden  herhangi birinin Tekla�nõn veya Computers &
Engineering�in yazõlõ izni olmadan herhangi bir araçla kopyalanmasõ veya herhangi bir şekilde yayõlõp çoğaltõlmasõ
kesinlikle yasaktõr.

Garanti ve güvenilirliğin sõnõrlarõ:

Dikkat:  Aşağõda açõklanan sõnõrlõ garantiler sadece burada ortaya konacak durum ve şartlar için geçerlidir. Burada
aksi belirtilmedikçe , �Telif  Hakkõ� ve �Ticari Marka Patent Haklarõ� İhlaline karşõ bir teminat  veya �Özel amaçlara
uygunluk� ve �Satõlabilirlik Garantisi� gibi teminatlarõ da içeren fakat bunlarla sõnõrlõ olmayan Garantilerden
herhangi birinin verildiğine dair sözlü veya yazõlõ, açõkça veya ima ile verilmiş bir beyanat yoktur.

Tekla şirketi (�Tekla�) ürettiği bilgisayar yazõlõmlarõnõn bu kullanõcõ kõlavuzunda ve her programla birlikte verilen ilgili Tekla
dokümanlarõnda açõklandõğõ şekilde kurulduğu , istenenler yerine getirildiği, gereğine uygun işletildiği ve Tekla tarafõndan
onaylanmõş bilgisayar ayarlarõnda kullanõldõğõ taktirde, çalõşacağõnõ garanti eder.

Buna ek olarak Tekla, bu kõlavuzun içerdiği bilgi ve açõklamalarõ yeterli eğitime sahip kullanõcõlar (duruma göre bizzat
programõ geliştirenler) veya uygun eğitimli inşaat-yapõ mühendisleri tarafõndan kullanõlmasõ halinde bilgisayar programõnõn,
beraberinde verilen dokümanlarda açõklanan esaslara göre çalõşacağõnõ garanti eder.

Bu Garanti Sözleşmesi Tekla�nõn müşterilerine, çalõşanlarõna, hizmetlilerine, temsilciliklerine ve taşeronlarõna karşõ
sorumluluklarõnõ düzenler. Bu garanti bunlarla sõnõrlõ olmamakla birlikte sözleşmeye bağlõ sorumluluklar veya hesaba
katõlmayan aksilikler ile Tekla çalõşanlarõnõn, hizmetlilerinin, temsilciliklerinin ve taşeronlarõnõn davranõş ve ihmallerinden
kaynaklanan sorunlar için de düzenlemeler getirir. Tekla , bu konu ile ilgili yasalarca belirtildiği halde bu  anlaşma dõşõnda
bõrakõlmamõş, anlaşma ile sõnõrlanmamõş ve değişiklik yapõlmamõş durumlarõn ve garantilerin uygulanmasõna da engel olmaz
ve kapsam dõşõ bõrakmaz.

Tekla kendi hazõrladõğõ bilgisayar yazõlõmlarõ dõşõndaki 3. grup bilgisayar yazõlõmlarõ için, üçüncü grup yazõlõm ürünleriyle
uyumlu olmasõ şartõyla bu kullanõcõ kõlavuzunda ve yazõlõm ile beraber verilen diğer dokümanlarda belirlenen sõnõra kadar
garanti sağlar. Tekla yazõlõmlar üzerinde Tekla�nõn yaptõklarõnõn dõşõndaki herhangi bir değişiklik ve düzeltme de bu garantinin
kapsamõ dõşõndadõr. Tekla yazõlõm ara yüzünün doğrudan kullanõmõ ile yazõlõm üzerinde yapõlan değişiklikler ve
geliştirmelerden kaynaklanan sonuçlar ve performans değişikliğinden sadece ve sadece bu değişiklikleri yapan kişi
sorumludur. Müşteri, Tekla�nõn yazõlõ onayõ olmadõkça yazõlõm üzerinde herhangi bir değişiklik ve düzenleme yapmaya yetkili
değildir.

Tekla�nõn bu garanti konusundaki tek sorumluluğu kullanõmõ engelleyen hatalarõ gidererek veya Tekla yazõlõmõnõ yenisi ile
değiştirerek bu programõn bu tür yazõlõmlara ait dokümanlarda yazõldõğõ şekilde çalõşmasõnõ sağlamaktõr. Ayrõca kullanõm
kõlavuzunda programõn kullanõmõnõ engelleyen hatalarõ gidermektir.
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Tekla kendi ürettiği yazõlõm ürünlerinde aşağõdaki konularõ garanti kapsamõ dõşõnda bõrakõr:

1. Müşterinin beklentilerine uymasõ

2. Hatasõz veya kesintisiz çalõşmasõ

3. Beraberinde verilen dokümanlarda tanõmlananõn dõşõndaki diğer uygulama paketleriyle de uyum içinde çalõşmasõ

4. Tekla�nõn onayladõğõnõn dõşõndaki donanõm veya donanõm biçimleriyle uyum içinde çalõşmasõ

Bu kullanõm kõlavuzuyla düzenlenenlerin dõşõnda Tekla aşağõda yazõlanlardan da sorumlu değildir:

1. Yazõlõmõn, beraberinde verilen kullanõm kõlavuzuyla uyum içerisinde kullanõlmamasõ veya bu konuda yetiştirilmemiş
elemanlarca eksik veya yanlõş kullanõlmasõndan

2. Bu kullanõm kõlavuzunda veya kendi donanõmlarõyla ilgili diğer yazõlõ dokümanlarda yer alan hatalardan
kaynaklanan hasar veya kayõplardan

3. Sözleşme hatasõndan veya herhangi bir yasal teoriden kaynaklanan dolaylõ, özel veya sonuçsal zararlardan (kar
gelirlerinin ve anlaşmanõn kaybõ dahil). Ancak bedensel yaralanma, can kaybõ veya mal kaybõnõn meydana geldiği
bir olaydan Tekla yazõlõmõnõn doğrudan sorumlu ve zararlõ olduğu yetkili ve ehil mahkeme tarafõndan tespit edilir ve
onaylanõrsa Tekla�nõn koyduğu sorumluluk sõnõrlarõ geçerliliğini yitirir. Böyle bir durumda bile Tekla�nõn zarar
tazminindeki sorumluluğu yasalarõn belirlediği sõnõra kadar bu zararlara neden olan yazõlõmõn lisans ücreti kadardõr.

Müşteri bu sorumluluklardan haberdar olduktan sonraki ilk on gün içerisinde Tekla�ya bu garanti sözleşmesindeki
sorumluluklarõn bir kõsmõndan veya tamamõndan haberdar olduğunu bir yazõ ile Tekla�ya bildirip haber vermedikçe bu
garantinin geçerliliği ve anlamõ yoktur.

Bu garanti sözleşmesi Finlandiya yasalarõyla bağdaşacak şekilde yorumlanmalõdõr.

Ticari Markalar
Windows NT Microsoft Şirketinin ticari bir markasõdõr.

Xsteel Tekla Şirketinin ticari bir markasõdõr.
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Ders 1-Örnek 1

Yeni Model Başlatma

3D Görünüş Oluşturma

Kolon Hatlarõ (Aks Hasõrõ) Oluşturma

Görünüşleri Oluşturma (Plan ve Yandan Görünüş)

Elemanlarõn Girilmesi
Kolonlar
Kirişler

Nokta Oluşturma

Birleşim Ekleme
Taban Plakalarõ
Alõn Plakalarõ
Gövde birleştirme (Fin) Plakalarõ

Eleman ve Birleşimlerin Çoğaltõlmasõ

1 ve 4 nolu Akslara Düşey Çapraz Ekleme



                                                                                                                      

Xsteel Eğitim Kursu                                                                                                                        Ders 1  � Train 1 Modeli

Copyright Tekla Oyj 2000,  Computers & Engineering 2002  Tel: 0049 6406 73667   www.comp-engineering.com                     Sayfa 1-2

CCCOOOMMMPPPUUUTTTEEERRRSSS   &&&
EEENNNGGGIIINNNEEEEEERRRIIINNNGGG



                                                                                                                      

Xsteel Eğitim Kursu                                                                                                                        Ders 1  � Train 1 Modeli

Copyright Tekla Oyj 2000,  Computers & Engineering 2002  Tel: 0049 6406 73667   www.comp-engineering.com                     Sayfa 1-3

CCCOOOMMMPPPUUUTTTEEERRRSSS   &&&
EEENNNGGGIIINNNEEEEEERRRIIINNNGGG

Yeni Model Başlatma

File çekme menüsünden New�i seçin veya New Model kutusunu tõklayõn.

Seçim bölgesindeki New Model iletişim kutusundan, �Xsteel_Models�i seçtikten sonra  \TRAIN1 yazõn
(Aşağõdaki örneğe bakõnõz).

Not: Model isminde (/  \   .  ;   :  | ) gibi özel karakterler kullanõlamaz.

OK tuşuna basõn. Yeni model oluşturdunuz.
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3d Görünüş Oluşturma

Çekme (pulldown) menüden sõrasõyla  View > Create View > Basic View veya Create Basic View
(Esas görünüşü oluştur) kutusuna çift tõklayarak 3d görünüş oluşturun.

View Properties iletişim kutusunu aşağõda gösterildiği gibi tamamlayõn ve Apply (uygula) tuşuna basõn.

Create Basic View iletişim kutusunda �koordinatõn� 0.0 olduğundan emin olduktan sonra görünüş
oluşturmak için Create (oluştur) tuşuna basõn.

Not: Up(üst) ve Down(alt) depth
(derinlik) o an ki görüntü düzleminin
alt ve üst derinliğini belirler. Görüntü
düzlemi seviyesi Create Basic View
iletişim kutusuna yazõlmõş
koordinattõr.
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Kolon Hatlarõ (Aks Hasõrõ) Oluşturma

Points (noktalar) menüsünden Grid�i (aks hasõrõ) seçin.

Aks çizgileri için X, Y ve Z�yi Grid iletişim kutusunda gösterildiği gibi tamamlayõn ve aks isimleri için
Labels (tanõm etiketleri) kõsmõnõ doldurun.

Not: 0,0 koordinatõnõndan geçen aksõ göstermek amacõyla ilk başa �0� girilir ve hasõr ayõrõcõsõ olarak da
boşluklar kullanõlõr.

Create tuşuna bir kez basõldõğõnda akslar oluşturulacaktõr.

Grid iletişim kutusunu kapatmak için OK�e basõn .

Aks çizgilerinin ekranõn sol alt köşesinde küçük olarak oluşturulduğunu göreceksiniz.  Görüntüyü tek
tõklayarak seçtikten sonra (çerçeve çevresinde kõrmõzõ çizgi belirince) farenin sağ tuşuna basarak Fit
Work Area�yõ (Çalõşma Alanõna Sõğdõr) seçin.
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Görünüşleri Oluşturma (Plan ve Yandan Görünüşler)

Create Basic View kutusuna bir kez daha çift tõklayarak plan görünüşler oluşturun.
View Properties iletişimi aşağõdaki gibi doldurduktan sonra Apply tuşuna basõn.

Not: Herhangi bir iletişim kutusuna bilgi girişi yapõldõktan sonra Apply veya OK�e basõlmasõ çok
önemlidir, aksi taktirde Xsteel bu bilgileri kullanmaz.

Not: Up ve Down görüntü derinliği 500 mm olarak değiştirilmiştir. Bu işlem, görüntü derinliğini
sõnõrlayarak o anki görüntü düzleminin 500 mm aşağõsõnda ve yukarõsõndaki elemanlarõn görülmesini
sağlayacaktõr.

Create Basic View iletişim kutusunda koordinatõn 0,0 olmasõna dikkat edin ve sonra Create tuşuna
basarak görüntü oluşturun. Şimdi RL 3200 kotundan bir plan görüntü oluşturun.  Bunu yapmak için
Create Basic View iletişim kutusunda koordinat olarak 3200 yazõn ve Create tuşuna basõn. Bunu 6500
kotu için tekrarlayõn.
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Şimdi Create View by two points (İki nokta ile görünüş üret)  kutusuna çift tõklayarak her aks için Yan
Görünüşler oluşturun.

View Properties iletişim kutusunu aşağõdaki gibi doldurduktan sonra Apply tuşuna basõn.OK�e basmaya
gerek yoktur, Apply yeterlidir.

Şimdi soldan sağa olarak 1 nolu aks üzerinde iki nokta seçin.

Bir çift ok işareti gözükecektir. Bunlar görünüşün yönünü belirtmektedirler.

2 nolu aks için View Properties iletişim kutusunu değiştirin ve Apply�a basõn. Sonra aks üzerinde iki
nokta seçin.

Bunu diğer akslar için de tekrarlayõn.
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İpucu:   Aynõ anda çok fazla görünüşün açõk olmasõ iyi bir fikir değildir.  Açõlmõş görünüşlerin sayõsõ
dokuz görünüş ile sõnõrlandõrõlmõştõr.  İsimlendirilmiş görünüşleri �abc� kutusuna basarak açõp
kapayabilirsiniz.
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Elemanlarõn  Girilmesi

Kolonlar

Kolonlarõ girmek için, Create Column kutusuna çift tõklayõn.
Column Properties iletişim kutusunu aşağõdaki gibi doldurun ve Apply  tuşuna basõn.

COLUMN

HEA300

S235JR
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3d görünüşte, kolon yerleştirmek için A ve 1 akslarõnõn kesişim noktasõnõ seçin.

B-1�e de şimdi başka bir HEA300 kolon yerleştirin.

Column Properties iletişim kutusunda HEA240 profil için gerekli değişikliği yapõn, Apply tuşuna basõn ve
kolonlarõ yerleştirin.

Diğer kolonlar için bu işlemleri tekrarlayõn.

B-3 kolonunun ekseni etrafõnda döndürülmesi gerektiğini fark edeceksiniz.  Bu, söz konusu kolonun
üzerine çift tõklayarak, o kolonun özelliklerinin ekrana getirilmesi ve bundan sonra rotasyonun �Front
(Ön)�dan �Top (Üst)�e getirilmesi ile yapõlabilir.  Bu ayarlardan sonra Modify tuşuna basmak
gerekmektedir.

B-4 kolonu ise aks çizgisinden bir miktar ötelenmiştir.  Bunu düzeltmek için ise Column Properties
iletişim kutusunda Vertical Position bölümüne istenen değer yazõlõr ve Modify tuşuna basõlõr.
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Kirişler

Kiriş girmek için Create Beam kutusuna çift tõklayõn.

Not: Kirişler, Çaprazlar, Tali kirişler, Aşõklar v.b. bu komut kullanõlarak girilebilir.

Beam Properties iletişim kutusunu aşağõdaki gibi tamamlayõn ve Apply tuşuna basõn.

BEAM

IPE300

S235JR
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RL 3200 plan görünüşünde, A-1 ve A-2 aks kesişim noktalarõnõ seçerek kirişi yerleştirin.

Not: Yatay elemanlar yerleştirirken (tutarlõlõk amacõyla)  her zaman soldan sağa veya aşağõdan yukarõya
doğru çalõşõn.

Şimdi diğer IPE300 kirişi girin.

Beam Properties iletişim kutusunu IPE240 için ayarlayõn, Apply tuşuna basarak kirişleri girin.

Bu işlemi diğer kirişler için de tekrarlayõn.

B-3 ve B-4 noktalarõ arasõnda kirişin aks çizgisinden şaşõrtõlmasõ istenmektedir.  Bunun için Beam
Properties iletişim kutusunda Position in Plane bölümüne gerekli değer girilmelidir.
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Nokta Oluşturma

Nokta Oluşturma araçlarõ modelde oluşturulacak noktalarõn hassas bie şekilde yerleştirilmesine izin
verir. Şimdi ara kirişleri Oluşturmada kullanõlacak noktalarõn üretilmesi için Create Parallel Points
kutusuna çift tõkalayõn, ve boşluğa 3500 2000 yazõn.  Apply tuşuna basõn.

A-1 ve A-2 aks kesişme noktalarõnõ seçin

Bu iki nokta, işlemin sonucunda 3500 ve sonrada 2000 mm olarak kopyalanarak ötelenecektir.

Komuttan çõkmadan A-3 ve A-4 kesişim noktalarõnõ da seçin.

Bu noktalar arasõna da IPE300 ara kirişler oluşturun.

Dik ara kirişler Oluşturmak için Create Extension Point kutusuna çift tõklayõn ve -3000 -1500 yazõn.

Aşağõda gösterildiği gibi 1 ve 2 noktalarõnõ seçin

Bunu yukarõdaki kiriş için de tekrarlayõnõz.
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Şimdi Create Divided Line Points kutusunu ve 1 değerini kullanarak A-1 ve A-2 noktalarõnõ eşit iki
parçaya bölelim ve nokta koyalõm.

Create Projection Point kutusuna tõkalyõn. B-1 ve B-2 kesişim noktalarõnõ seçin.
Komut satõrõnda iz düşürülecek nokta sorulacaktõr.  Bundan sonra Create Extension Point ile
oluşturduğumuz noktalarõ seçerek izdüşürelim.

Profili değiştirmek isterseniz Beam kutusunu çift tõklayarak Beam Properties iletişim kutusunu açõn.
Kirişin kalan kõsõmlarõnõ da modelleyin. Sürekli soldan sağa ve aşağõdan yukarõya çalõşmayõ unutmayõn.
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Birleşimler Eklemek

Birleşimler, makrolar kullanõlarak çok hõzlõ bir şekilde modellenebilirler. Makrolar ile çalõşõrken en büyük
avantajlarõnõz:

1. Makro ayarlarõnõ dilediğiniz zaman belli isimler altõnda kaydedebilirsiniz. Bu ayarlar daha sonra
bir çok projede kullanõlabilir.

2. Modeldeki kesitlerde yapõlan değişiklikler, aynõ zamanda otomatik olarak makrolar üzerinde de
yapõlõr.

3. Edit, copy veya mirror gibi seçenekleri seçtiğinizde tüm birleşimler otomatik olarak seçime dahil
edilir. Kopyalanan veya eşi çõkarõlan birleşimler orijinali ile tamamen aynõdõr. Tüm bunlar
plakalar ve cõvatalar içinde geçerlidir.

Makrolar Xsteel ekranõnõn sağ yan tarafõnda bulunur. Kullanõcõ (oklar üzerine)

tõklayarak değişik taraflar arasõnda gidip gelebilir. Xsteel bir çok birleşim için makro bulundurur.

Makrolar iki (2) geniş gruba ayrõlõr: iki veya daha fazla kirişi bağlayan joint�ler (düğüm noktalarõ) ve
sadece bir tek kirişi içeren details (detaylar). Makronun ilk grubu, kullanõcõdan, iki kesit seçilirken
kesitlerin sõrasõ ile tõklanarak seçilmesini ister (önce ana kõsõm ve sonra da tali kõsõm). İki kirişten fazlasõ
ile çalõşan makroda kiriş seçim işlemi fare orta tuşuna basõlarak sonlandõrõlabilir.

İkinci grup makro durumunda (=detail�ler) Xsteel kullanõcõdan detay için bir kesit (mesela bir kolon) bir
de nokta ister (mesela taban plakasõ). Bu nokta kolonun alt kõsmõnda bulanan bir noktadõr.

Birleşim başarõyla yapõlmõşsa sembol yeşil olacaktõr. Birleşim başarõyla yapõlamadõysa sembol kõrmõzõ
olur. Eğer sembol sarõ olursa birleşim ile bir sorun var demektir. Sarõ olarak görünen bir birleşimi sorunu
tespit etmek için yakõndan incelemek gerekir. Sarõ sembol genellikle, cõvata veya deliklerin kenar
paylarõnõn, birleşim için önceden belirlenen değerlerden daha küçük olmasõ ile alakalõdõr. Kõrmõzõ
sembolün veya başarõsõz birleşimin en sõk rastlanan sebebi de �yukarõ yön�ün yapõlan birleşim için
uygun olmayõşõdõr. Çoğunlukla otomatik seçimler �yukarõ yön�ü dikkate alõr ama karmaşõk durumlarda bu
yön kullanõcõ tarafõndan dõşarõdan tanõmlanmalõdõr. �Yukarõ yön�düğüm noktasõ sembolündeki okun yönü
ile tanõmlõdõr. Kullanõcõ birleşime uygun �yukarõ yön�ü, kullandõğõ makro için Help (yardõm) menüsüne
başvurarak bulabilir. Normal �yukarõ yön� makronun Picture seçeneğinde gösterilmektedir. Yön
değiştirme işlemi için modeldeki sembolü seçin. Daha sonra makronun General seçeneği üzerinden x,y
ve z koordinatlarõnõ değiştirip Modify tuşuna basõn.

                            Makroda �yukarõ yön� kritik bir öneme sahiptir!
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Cõvata gruplarõ ve koza deliklerin ayarlarõnõ yapmak için  Xsteel yatay ve düşey yöndeki cõvata
mesafelerini sorar. Makrolarda okun yönünün düşey yönde alõnmasõ kolaylõk sağlar.

Pozisyon numaralarõ, malzeme ve cõvata birleşimleri ile ilgili ayarlarõn tamamõ makro ayarlarõ içinde
yapõlabilir. Tüm şartlarõn tamamõ makroda belirtilmelidir. Bu ayarlar projenin hazõr tanõmlõ değerleri
olarak muhafaza edilebilir.

Düşey

Ya
ta

y
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Taban Mesnet Plakalarõ

İlk ekleyeceğimiz  birleşim kolon Taban Plakalarõdõr. Makro yan menüsünün üçüncü sayfasõndan
Base plate (1004) makro kutusuna çift tõklayõn. Aşağõdaki iletişim kutusu belirir:

�Apply� veya �OK� tuşuna tõklayarak önceden tanõmlõ değerleri uygulayõn, önce kolonu ardõndan da
kolonun tabanõndaki noktayõ seçin.

Dikkat: Komut satõrõ sizden önce parçayõ sonrada noktayõ seçmenizi isteyecektir.Komut satõrõ bilgisini
sürekli ve dikkatle izleyin.

Yanlõş �yukarõ yön� durumunda �Illegal Z-direction� mesajõ belirir ve makro oluşturulamaz.
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Taban mesnet plakasõ makrosunu denemek amacõyla yeşil makro sembolü üzerine çift tõklayõn ve
dilediğiniz bir parametreyi değiştirin.

Örneğin taban plakasõ kalõnlõğõnõ �Parts� seçeneği altõndaki sayfada girebilirsiniz.

Bu taban plakasõnõ diğer kolonlarda da değiştirmeden kullanmak istiyorsanõz makro ayarlarõnõ
uygulayabilirsiniz. Ve şimdi Base plate(1004)� ü diğer kolonlara ekleyebilirsiniz.

Alõn plakalarõ   

Makrolarõn 1. sayfasõndaki End Plate (29) makro kutusu üzerine çift tõklayõn.

Önceden tanõmlõ ayarlarõ uygulayõn ve ana parçayõ seçin (A1 Aks çizgileri kesişim noktasõndaki kolon)
daha sonra da tali parçayõ seçin ( 3200 seviyesindeki 1. aks çizgisi  üzerindeki kiriş).   

Dikkat:  Bu makro kutusu bir  kiriş- kolon birleşimini göstermekle beraber bu makro  hem diğer kiriş-kiriş
hem de kolon-kolon  birleşimlerinde  kullanõlabilir.
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Cõvatalarõ , �Bolts� sayfa seçeneğine tõklayarak açtõğõnõz form üzerinde tanõmlayabilirsiniz.

Düğüm noktasõ katkõlarõnõ düğüm noktasõ sembolü üzerine çift tõklayõp değerler girerek ve �Modify�
tuşuna basarak değiştirebilirsiniz.

Tüm ana aks kirişlerine alõn birleşim plakasõ eklemeye devam ediniz.

Dikkat: Çift taraflõ alõn birleşim plakalarõ için  Two Sided End  Plate (çift taraflõ alõn plakasõ) makrosunu
(142) kullanmalõsõnõz.

Gövde birleştirme Levhalarõ (Fin Plates)

Makronun 6. sayfasõndaki Shear Plate Simple (146) makro kutusuna çift tõklayõn.

Önceden tanõmlõ değerleri uygulayõp ilk olarak ana parça ( destekleyici kiriş ) sonra da yardõmcõ tali
parçayõ (desteklenen kiriş) seçin.

Tüm ara kirişlerin gövde birleştirme Plakasõ birleşimlerini eklemeye devam edin.

Gövde birleştirme Plakalarõnõn, birleşimlerin kuzey veya batõsõna diğer bir deyişle sol veya üst kõsmõna
konduğundan emin olun.
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Elemanlarõn ve Birleşimlerin Çoğaltõlmasõ

Şimdi de Xsteel�in görüntü filtresi özelliğini kullanarak kolonlarõ görünmez yapacağõz. Böylece kirişlerin
tamamõnõ seçmek daha kolay olacak.

Üç boyutlu görüntüde siyah bölgenin herhangi bir yerine çift tõklayarak bu görünüşe ait iletişim kutusunu
görüntüleyin.

Filter tuşuna basõn ve açõlan iletişim kutusunu aşağõdaki gibi tamamlayõn:

Şimdi Modify tuşuna basarak kolonlarõ filtre edip sadece kirişlerin görünmesini sağlayõn.

Kirişleri seçmek için , imleci, tümünü kesecek şekilde sürükleyin ve ekranõn üst kõsmõndaki Copy �
Translate kutusuna tõklayõn.

Copy  iletişim kutusundaki Dz  değeri için 3300 girin ve Copy�ye basõn. Şimdi tüm kiriş ve kiriş
birleşimleri 6500 kotundaki kat�a kopyalanmõş oldu.
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1. ve 4. Akslara Çapraz Eklemek

1 no�lu Aks görünüşü kotunda çalõşarak, Beam Properties iletişim kutusunu kullanõp düşey çapraz
elemanlarõnõ girin. Position alanõna �middle� yazmayõ unutmayõn.

Çaprazlarõ kolonlara bağlamak için Tube Gusset (20) makrosunu kullanõn. Önce ana elemanõ (kolonu)
ardõndan (yardõmcõ) tali elemanlarõ seçmelisiniz,  tali elemanlarõn (çaprazlarõn) seçimini tamamladõğõnõzõ
onaylamak için de fare orta düğmesine basmalõsõnõz.

Dikkat: Makroyu uygularken �Kuraldõşõ Z-yönü� hata mesajõnõ alõyorsanõz �yukarõ yön�ü makronun genel
seçeneklerinden ayarlamanõz gerekebilir. Temel olarak+X,+Y ve +Z gibi pozitif yönleri deneyin.  
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Ders 2 � Eğitim 2

  İlk önce çizim(ler)i ve  aşağõdaki konularõnõ inceleyin.
•  Yeni bir model başlatmak
•  Üç boyutlu görünüş oluşturmak
•  Aks  çizgilerini  oluşturmak
•  Görünüşler oluşturmak (plan ve yan görünüşler)

Elemanlarõn girilmesi 2

Taban mesnet plakasõ detaylarõnõ oluşturmak 4

     Plakalar  4

    Nervür plakalarõ 4

    Delik delme 5

Taban mesnet plakasõ kullanõcõ detaylarõnõ oluşturmak 7

Tepe plakasõ birleşimlerinin program araçlarõ kullanõlarak oluşturulmasõ  8

Kirişe delikler açmak 9

   Çokgen kesim 9

   Kõsmi kesim 10
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Elemanlarõn Girilmesi

Kolonlarõ eğitim 2 çizimlerinde gösterildiği gibi girin (taban seviyesini �200 kotuna, üst başlõk seviyesini
ise 5100 kotuna ayarlayõn.)

Öncelikle B-1 aks kesişme noktasõndaki kolonun üst başlõk noktasõna , ardõndan  B-3  aks kesişme
noktasõndaki kolonun üst başlõk noktasõna tõklayarak B aksõ üzerinde bir kiriş oluşturun. 2 nolu  aks
üzerinde bir kiriş oluşturmak için önce 2 nolu aks çizgisindeki yan görünüş üzerindeki A-5500 kesişme
noktasõnõ ardõndan da B-5500 kesişme noktasõnõ seçin.

Diğer bir alternatif ise her iki kirişi de +5.500 T.O.S. seviyesine yerleştirip sonrada B aks çizgisindeki
kirişi, kirişe ait �position in depth� bölgesine 400 yazarak aşağõ düşürmektir.

2 nolu  aks üzerindeki kirişe ait konsolu, bu elemanõn Beam Properties diyalog kutusundaki �Move
End1� ve �Move End 2� değerlerini ayarlayarak kontrol edebilirsiniz.
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Tepe plakasõna ait detaylarõ, programõn ara yüzlerini kullanarak oluşturmak

Plaka

RL �0.200 kotunda  oluşturulmuş plan görünüşünü kullanarak, biri A-2 aks kesişme noktasõndan  +300
mm uzakta, diğeri de aynõ noktadan  -300 mm uzakta Y yönünde iki nokta oluşturun. Bu noktalar taban
mesnet plakasõnõn başlangõç ve bitiş noktalarõdõr. Kiriş özellikleri (Beam Properties) diyalog kutusunu
kullanarak taban plakasõ profilini �PLT25*300� (PL25*300) olarak girin. Profil ismini de �PLATE� olarak
değiştirin. Malzeme olarak mesela S235JR kullanõn. Apply tuşuna basõn ve ardõndan taban plakasõnõn
önce başlangõç sonrada bitim noktasõna tõklayõn.
Şimdi de taban plakasõnõ 90 derece döndürmemiz gerekecek. Bunun için �Rotation� õ �Top� tan �Front�a
değiştirin. Sonrada taban mesnet plakasõnõn alt yüzünün RL �2.00 kotunda olduğundan emin olmak için
Beam Properties formunda bulunan ve konum (Position) bildiren �Depth� kutusundaki değeri �Behinde�
dan �Front� a değiştirin.

Şimdi de kolonumuzun taban plakasõ üzerine tam oturmasõ için budanmasõ gerekmektedir. Bu amaçla
sol taraftaki menüden �fitting� komutunu kullanarak kolonun alt kõsmõnõ kesip kõsaltõn.
Komutu başlatarak önce kolonu ardõndan da taban mesnet plakasõnõn üst kenarõ boyunca bulunan iki
noktayõ seçin.

Nervür plakaları

Nervür plakasõnõ oluşturmak için öncelikle 2 no lu akstaki yan görünüş üzerinde bu plaka için gerekli
noktalarõ düzenleyip yerleştirin. Daha sonra Contour Plate makrosunu kullanõp yerleştirilen noktalarõn
her birini sõrasõ ile seçerek bu plakayõ oluşturun.

PLATE

PL10

S235JR



                                                                                                                      

Xsteel Eğitim Kursu                                                                                                               Ders 2  � Train 2  Modeli

Copyright Tekla Oyj 2000,  Computers & Engineering 2002  Tel: 0049 6406 73667   www.comp-engineering.com                     Page 2-5

CCCOOOMMMPPPUUUTTTEEERRRSSS   &&&
EEENNNGGGIIINNNEEEEEERRRIIINNNGGG

Kaynak makrosunu kullanarak nervür plakasõnõ kolona kaynaklayõn.
Sonrada taban plakasõnõ kolona kaynaklayõn.

Dikkat:  Doğru bir çizim elde etmek için kaynak sõrasõnõ doğru girmek oldukça önemlidir. Önce ana
parçalarõ sonra da tali parçalarõ seçerek işlemleri uygulayõn.

İkinci bir kez nervür plakasõ oluşturmaktan kurtulmak için ayna tutma (simetriğini almak da denebilir)
özelliğini kullanarak kolonun diğer tarafõna da bir plaka yerleştirelim.

 2 No�lu  akstaki yan görünüş üzerinde çalõşõrken çalõşma düzlemini aktif görüntü düzlemine taşõyõn.
Bunun için ekranõn üst kõsmõndaki Set Workplane to View Plane  ikonuna tõklayõn ve 2 nolu  akstaki
yan görünüşü seçin.

Nervür plakasõnõ seçip aktif hale getirdikten sonra şimdide ekranõn üst kõsmõndaki Copy –Mirror tuşuna
basõn.

Şimdi de kolonun merkez çizgisi üzerindeki iki noktayõ düşey olarak seçin ve Copy/Mirror diyalog kutusu
üzerindeki Copy tuşuna tõklayõn.

Dikkat: Ayna komutu seçilen parçalarõn, çalõşma düzlemini dikine kesen ve belirtilen çizgiden geçen bir
düzleme göre simetriğini alõr. Nervürlerin simetriğini almanõn diğer bir yolu ise üç boyutlu görünüşte
çalõşma düzlemini plan görünüş düzlemine ayarlamadan bazõ noktalarõ mesala A-1 ve A-3 noktalarõnõ
seçmek olabilir.

Dikkat: Kaynaklar da nervür plakalarõ ile beraber otomatik olarak kopyalanõr.

Delikler Eklemek

Son olarak da taban mesnet plakasõnõn deliklerini delmemiz gerekiyor.

Ekranõn üst kõsmõndaki  Set Workplane to View Plane  ikonunu kullanarak çalõşma düzlemini tekrardan
üç boyutlu görünüşe geri taşõyõn.

Plan görünüş üzerinde RL -0.200 kotunda 2 no�lu aks çizgisi  boyunca, tercihen taban mesnet
plakasõnõn kenarlarõndan 50 mm içerde kalacak şekilde iki nokta oluşturun. İlk ve son cõvatalar buradan
geçecektir.
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Bolt makrosunu kullanarak diyalog kutusunu aşağõdaki gibi tamamlayõn.

Bu ayarlarõ uygulayõn, taban mesnet plakasõnõ seçin ve sonra fare orta tuşuna basõn.

Şimdi de henüz oluşturulmuş bu noktalardan önce birini sonra da diğerini  seçin.
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Taban Mesnet Plakasõ Kullanõcõ Detaylarõnõ Oluşturmak

Az önce program ara yüzlerini kullanarak oluşturduğumuz bu taban mesnet plakasõ detaylarõnõ diğer
kolonlarda da kullanabileceğimizden, bu birleşimi kullanõcõ detaylarõna ekleyebiliriz. Xsteel hem kullanõcõ
düğüm noktasõ hem de kullanõcõ detayõ oluşturabilir. Kullanõcõ düğüm  noktasõ esasen; kullanõcõ
tarafõndan, programõn ara yüzleri kullanõlarak iki eleman arasõnda oluşturulmuş bir bağlantõ demektir.
Bunun yanõnda kullanõcõ detayõ; bir elemana tutturulmuş bir detayõ anlatõr. Örneğin; taban mesnet
plakasõ, kesme pimleri, v.s..

Bir kullanõcõ detayõ oluşturmak için ilk olarak detayõn tüm parçalarõnõ seçmiş olmalõsõnõz. Mesela; taban
mesnet plakasõ, kaynaklar, nervür plakalarõ, cõvatalar ve kesikler.

Çekme Detailing menüsünden Create detail�i seçin.

Userjoint Properties (kullanõcõ detayõ özellikleri) diyalog kutusundaki isim alanõna �Baseplate� yazõn.

Taban mesnet plakasõ X-Y düzlemi üzerinde iken düğüm noktasõ yönünü +X olarak değiştirin.

Dikkat: Eğer taban plakasõ düşeyde ise (alõn plakasõ gibi0), taban mesnet plakasõ Z düzleminde
olacağõndan siz de detay için +Z yönünü kullanacaksõnõz.

Pozisyon tipini collision plane (çarpõşan düzlemler) olarak bõrakarak önce Apply tuşuna sonrada OK�e
basõn.   

Ana parçayõ (kolonu) seçin ve sonra taban mesnet plakasõnõn üzerine basacağõ noktayõ seçin (Bu nokta,
RL -0.200  kotunda, kolonun aks çizgisi üzerine denk gelen noktadõr.)

Bu detayõ şimdi diğer kolonlarda da kullanabilirsiniz. Bunun için sõrasõyla User Joint ikonunu, ardõndan
Baseplate kullanõcõ düğüm noktasõnõ, sonra kolonun kendisini ve nihayet taban mesnet plakasõnõn tam
alt yüzündeki noktayõ seçin.

Taban mesnet plakasõ detayõnõ 90 derece döndürmek için (B aks çizgisi  üzerindeki kolonlar için)
Userjoint sembolü üzerine çift tõklayõp düğüm noktasõ yönünü +Y  olarak değiştirin.   
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Tepe plakasõ Bağlantõsõnõ program ara yüzlerini  kullanarak Oluşturmak

Program ara yüzlerini kullanarak tepe plakasõ oluşturma işlemi, taban plakasõ için yapõlanõn aynõsõdõr.

Tavsiye:  İki tepe plakasõ ve bunlarõn cõvata grubuna ait noktalarõ düzenlemek için RL5088 kotunda bir
plan görünüş oluşturabilirsiniz. Bir sonraki tepe plakasõnõ oluşturmak için,  position altõndaki �depth�
ayarõnõ  front�a değiştirin. Bir diğer tepe plakasõnõ da; aynõ ayarõ  Top� a değiştirerek  oluşturun.

Tavsiye: Cõvata ayarlarõnõ uyguladõktan sonra cõvata konacak kõsõmlarõ seçmeniz istenecektir. Üç
boyutlu görünüşte alt plakayõ seçin ve sonra tekrar �cõvata konacak kõsmõ seçin� ( pick part to be bolted)
uyarõsõnõ aldõğõnõzda üst plakayõ seçin. �Diğer kõsõmlarõ seçin� komutunu aldõğõnõzda fare orta tuşuna
basarak seçimlerinizi girin.
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Kirişe Delikler Açmak

Çokgen Kesim

Kirişin sol alt köşesine bir kertik açmak için Polygoncut komutunu kullanacağõz. Kirişin konsol yapan
kõsmõnõ yakõnlaştõrõn (A2 Aksõnõn yakõnõnõ).

İlk iş olarak, noktalarõ aşağõda gösterildiği gibi oluşturun :

Dikkat: Noktalar çelik malzemenin dõşõna doğru taşõrõlõrlar. Eğer noktalar çelik malzemenin köşesine
denk gelecek şekilde oluşturulursa, kesim sonrasõnda, kesilen köşeler boyunca ince bir malzeme kalõr.
Çünkü Xsteel böyle bir durumda bizim malzemeyi kertmek istediğimizi değil delmek  istediğimizi
zannedebilir.

 Polygoncut ikonuna basõn, kirişe tõklayõp sonra yukarõsõnda oluşturulmuş noktalarõ seçin.

Sonra kirişin yaklaşõk ortasõna doğru taşõyarak dikdörtgen bir çokgen kesme bölgesi oluşturun. Kirişin
gövdesinde de bir delik açmak için aynõ işlemi tekrarlayõn (2 no�lu Akstaki yan  görünüşü inceleyin).

 Dikkat: Poligon kesimin etkilerini görebilmek için üç boyutlu görünüş  ve yan görünüşler için görüntü
özellikleri ekranõnõ �Exact�a ayarlamanõz gerekecektir.
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Kõsmi Kesme İşlemi

Kirişin üzerine yuvarlak bir delik açmak için Partcut komutunu kullanacağõz.

Öncelikle 2 no�lu akstan geçen düşey düzlem üzerinde, çap 200�lük bir profilin merkezini temsil eden bir
nokta oluşturun.

Bu noktayõ önce negatif  X yönünde 200mm sonrada pozitif  X yönünde 200mm kadar uzağa
kopyalayõn.

Beam Properties diyalog kutusunu kullanarak profil için D200 girin. Bunu yaparken de düzlem (plane) ile
derinlik (depth) konumlarõnõn �Middle�e ayarlanmõş olduğundan emin olun.

2 no�lu aks çizgisi nin her iki yanõnda oluşturulan iki noktayõ seçerek profili girin. Bu işlem girdiğiniz
elemanõn kiriş gövdesini delerek karşõya geçmesini sağlayacaktõr.

Bu elemanõn çevresini kesmek için Create partcut  ikonuna basõn ve kirişi seçerek D200 (çap 200)
profil üzerine tõklayõn.

Şimdi D200 profilini iptal edin. Ardõndan mavi renkte kõsmi bir kesik bõrakacaktõr.

Bu işlemi diğer dikdörtgen kõsmi kesme işlemi için de tekrarlayõn, fakat bu kez 45 derece döndürülmüş
PLT 200*200 profilini kullanõn. Bu döndürme işlemi, elemanõn  kiriş özellikleri diyalog kutusundaki
�rotation� alanõna 45 yazõlarak gerçekleştirilebilir.
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Ders 3 - Eğitim 3

İlk önce çizimleri ve aşağõdaki konularõ gözden  geçirin.

•  Yeni bir model başlatmak
•  Üç boyutlu görünüş oluşturmak
•  Aks çizgilerini oluşturmak
•  Üç boyutlu, plan ve yan görünüşler oluşturmak
•   Sadece 1 no�lu portal aks için eleman girilmesi (iki kolon ve bir tali kiriş)

Çaprazlar ve aşõklarõ  oluşturmak için gerekli tüm noktalarõn yerleştirilmesi

Yatay Çaprazlama
Aşõklar

Portal çerçeveye ait birleşimlerin oluşturulmasõ

       Portal çerçeve ve noktalarõnõn kopyalanmasõ

A 5 aksõ  boyunca düşey duvar çaprazlarõn eklenmesi

Yatay çatõ çaprazlar için eğimli bir çalõşma düzlemi oluştur

       Çalõşma düzlemi

       Gerçek plan görünüşü

Yatay çaprazlar eklenmesi

Aşõklar için eğimli çalõşma düzlemi oluşturulmasõ

      Gerçek plan görünüş

      Çalõşma düzlemi

Aşõklar

      Parametrik profiller
      Aşõk eklenmesi
      Aşõk uçlarõnõn çatõ kirişlerine birleştirilmesi
     Geri kalan aşõklarõn bağlanmasõ

Çakõşma  Kontrolü



                                                                                                                      

Xsteel Eğitim Kursu                                                                                                                        Ders 3  � Train 3   Modeli

Copyright Tekla Oyj 2000,  Computers & Engineering 2002  Tel: 0049 6406 73667   www.comp-engineering.com                     Sayfa 3-2

CCCOOOMMMPPPUUUTTTEEERRRSSS   &&&
EEENNNGGGIIINNNEEEEEERRRIIINNNGGG



                                                                                                                      

Xsteel Eğitim Kursu                                                                                                                        Ders 3  � Train 3   Modeli

Copyright Tekla Oyj 2000,  Computers & Engineering 2002  Tel: 0049 6406 73667   www.comp-engineering.com                     Sayfa 3-3

CCCOOOMMMPPPUUUTTTEEERRRSSS   &&&
EEENNNGGGIIINNNEEEEEERRRIIINNNGGG

Çaprazlar ve aşõklarõ  oluşturmak için gerekli tüm noktalarõn
yerleştirilmesi
İki kolon ve bir çatõ kirişini girdikten sonra aşõklar ile düşey ve yatay çaprazlarõ modellemek için gerekli
noktalarõn yerlerini oturtmanõz gerekir.

Yatay Çaprazlama

Çekme Points menüsünden Axis Intersection�õ seçin, sonra A1 aks çizgisi  üzerindeki kolonu ardõndan
da çatõ kirişini seçin. Bu komut kolon ve çatõ kirişinin akslarõnõn kesiştiği yerde bir nokta oluşturacaktõr.
Bu işlemi çatõ kirişinin diğer ucunda da tekrarlayõn.

Şimdi de Create extension point komutunu kullanarak �500 yazõn ve bu kesişim noktalarõndan önce
birini sonra da diğerini seçin. Şimdi de bu seçme işlemini sõrayõ tersinden başlayarak tekrarlayõn. Bu
işlem ilk ve son çapraz noktalarõnõ oluşturacaktõr.

Create divided line points komutunu kullanarak 3 (3 nokta) yazõn ve yapõlacak çaprazlama işlemi için
yeni bir ilk ve son nokta seçin. Bu işlem bu iki noktayõ dört eşit parçaya böler (3 nokta).

Aşõklar

Create extension point komutunu kullanarak -350 yazõn. Ardõndan çatõ kirişinin A  aksõnda bulunan
bitim noktasõnõ seçin. Sonrada bu kirişin B Aksõ üzerindeki diğer bitim noktasõnõ seçin.

Create divided line points komutunu kullanarak 4 yazõn (4 nokta) ve  Create extension point
yardõmõyla oluşturduğunuz noktalarõn hepsini birer birer seçin. Bu işlem bu iki noktayõ beş eşit parçaya
ayõrõr.
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Portal çerçeveye ait birleşimlerin oluşturulmasõ

Şimdi kirişe gusseli bağlantõ eklemek için makrolarõn dördüncü sayfasõndaki Haunch (40) makrosunu
kullanõn. Önce ana elemanõ (kolonu) sonrada tali elemanõ (çatõ kirişini) seçin.

Kolonun tepesine bir uç plakasõ yerleştirmek için �parts� seçeneğinden �Cap plate� altõndaki  kalõnlõk (t)
alanõna 10 girin ve modify tuşuna basõn.

Portal  çerçeveyi bitirmek için kolonlara sayfa 3 teki taban plakasõ (1004) birleşimlerini de ekleyin

Portal çerçevenin ve noktalarõn kopyalanmasõ

Bitmiş haldeki portal çerçeve, çapraz ve aşõk çalõşma noktalarõnõn tamamõnõ kopyalamak için portal
çerçevenin tüm parçalarõnõ pencere içine alarak seçin.

Ekranõn üst kõsmõndaki Copy- Translate ikonuna basõp önce A ve 1 akslarõ kesişim noktasõnõ  ardõndan
da A ve 2 akslarõ kesişim noktasõnõ seçin. Bu işlem kopyalama diyalog kutusundaki ölçümlendirme ve
yön bildirme işlemlerini tamamlayacaktõr.            

İstediğiniz kopya sayõsõnõ yazõn (4) ve Copy tuşuna basõn.   
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A Aksõ boyunca duvar çaprazõ eklenmesi

Beam Properties diyalog kutusunu kullanarak A Aksõ yan görünüşü üzerinde düşey çaprazlarõnõzõ girin.

Sayfa 2�deki Tup Gusset (20) (Tüp gusse) makrosunu kullanarak çaprazlarõ kolona bağlayõn. Önce ana
elemanõ (kolonu) sonrada tali eleman(lar)õ seçin. Tali elemanlarõ seçme işlemini tamamladõğõnõzda
seçimi onaylamak için fare orta tuşuna tõklayõn.

Dikkat: �Genel� seçeneğindeki otomatik yukarõ yön seçeneğini kullanõrken makrolar için istenmeyen bir
yukarõ yön seçilmiş olabilir. Bu yüzden temel olarak ilk önce poztif yönleri deneyin. Örneğin: +X, +Y ve
+Z.   
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Çapraz için eğimli bir çalõşma düzlemi ayarlamak

Çalõşma Düzlemi

Çalõşma düzlemini çatõ eğimine ayarlamak için ekranõn üst kõsmõndaki Set Workplane by 3 Points
ikonunu seçin.
Sonrada komut satõrõndaki yol göstermeleri izleyerek noktalarõ aşağõdaki gibi seçin.

+Y Doğrultusunda
Nokta

Başlangõç Noktasõ

+X Doğrultusunda
Nokta
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Gerçek plan görünüşü
Çatõ çaprazlarõnõ eklemeyi kolaylaştõrmak amacõyla, çalõşma düzlemine dik bir görünüş
oluşturarak  çatõ kirişleri üzerinde bir �gerçek plan görünüşü� oluşturun.

Çekme Properties menüsünden View�i seçin.Görünüşü �TRUE PLAN � ROOF BRACING� adõyla
adlandõrõp, sonra �up� ve �down� değerlerinin her birini 500�e ayarlayõn.

Ardõndan açõyõ da �Plane�e çevirin ve View Properties diyalog kutusunu böylece tamamlayõn.
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Yatay çapraz eklemek

Çatõ çaprazõ üzerindeki gerçek plan görünüşünü kullanarak çapraz elemanlarõnõ ekleyin.

Bu çaprazlarõn doğru yerleştirilip yerleştirilmediğini kontrol etmek için üç boyutlu (3D) görünüşü ve 1
no�lu akstaki yandan görünüşü inceleyin.

Çaprazlara bağlantõlarõ sayfa 2�deki Tup Gusset (20) makrosunu kullanarak yapõn.

Çaprazlarõ bir kez modelleyip bağladõktan sonra, Copy ve Mirror komutlarõyla 3 no�lu aks çizgisi
üzerindeki iki noktayõ kullanõp, 4 ve 5 no�lu akslar arasõnda yatay çaprazlar oluşturun.

Dikkat: Nesneleri modellemek için gerçek düzlem üzerinde çalõşmak her zaman daha doğru sonuçlar
verir. Modelleme yaparken yakalayõp kullanmanõz gereken noktalarõn tümünün aynõ düzlem üzerinde
olmasõ doğruluğu arttõracaktõr. Çalõşma düzlemi üzerindeki noktalar sarõ çarpõlarla gösterilir ve kõrmõzõ ile
gösterilenlere göre öncelikleri vardõr.
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Aşõklar için eğimli çalõşma düzlemi oluşturma

Gerçek plan görünüşü

Çalõşma düzlemini taşõmadan önce aşõklar üzerinde bir �gerçek� plan görünüşü hazõrlayõn.

Create view by three points komutunu kullanarak aşõklar için bir �gerçek plan görünüşü� oluşturun.
Ekranõn üst sol köşesindeki ikon üzerine çift tõklayõn. Açõlan View Properties diyalog kutusunu �TRUE
PLAN � PURLINS� olarak adlandõrõp �up� ve �down� değerlerine ayrõ ayrõ 500 girerek açõyõ �Plane�e
çevirin. OK tuşuna tõklayõn ve aşağõda gösterilen noktalarõ seçin.

Work plane

Çalõşma düzlemi



                                                                                                                      

Xsteel Eğitim Kursu                                                                                                                        Ders 3  � Train 3   Modeli

Copyright Tekla Oyj 2000,  Computers & Engineering 2002  Tel: 0049 6406 73667   www.comp-engineering.com                     Sayfa 3-10

CCCOOOMMMPPPUUUTTTEEERRRSSS   &&&
EEENNNGGGIIINNNEEEEEERRRIIINNNGGG

Şimdi ekranõn üst kõsmõndaki Set workplane to viewplane ikonunu seçip aşõklar üzerindeki �gerçek
plan görünüşü�nde herhangi bir yere tõklayarak çalõşma düzleminizi taşõyabilirsiniz.
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Aşõklar

Parametrik Profiller

Aşõklarõ modellemeden önce kullanacağõnõz profili seçmeniz gerekmektedir. Bu eğitimde
sactan imal bir şekil kullanalõm. Her ne kadar �profil veri tabanõnda� sacdan imal şekiller
mevcut değilse de; Beam Properties diyalog kutusundaki profil özellikleri yazõ kutularõnõ
kullanarak parametrik bir profil tarif edebilirsiniz. Bu işlemi ekran menüsünden Help ->
Contents -> Modeling -> Appendixes -> Parametrik profiles sõrasõnõ takip ederek
yapabilirsiniz. Şimdi ekranda mevcut parametrik profilleri gösteren bir yardõm ekranõnõ
görebilirsiniz. Aşağõ kayõp ZZh-s-t1*b1-t2*b2 etiketli olanõnõ seçin.

 Parametrik profilleri girmek için kullanõlan format; isimlendirme için büyük harfler, gerekli
ilave bilgiler için küçük harfler ve numaralar kullanmak biçimindedir.

Profil veri tabanõna profil eklemek için:

İstenilen şekli profil veri tabanõna eklemenin bir başka yolu da vardõr.
Select File -> Database -> Profiles -> Modify...
Çekme Type menüsünden aşağõdaki şekilde gösterilen Z stilini seçin ve kesit özelliklerini gösterildiği gibi
doldurun.
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Dikkat: girdi ve csnr kutularõnõn 1�e eşit olmasõna ve cstype�in Default�e ayarlõ olmasõna dikkat edin.
(csnr = kesit numarasõ)
Profil isminin altõndaki Add tuşuna basõn.

OK tõklayõn ve sonra Save Database, To Working Directory seçeneğini seçerek tekrar OK tuşuna
tõklayõn.

Aşõklar eklemek
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Kiriş ikonu üzerine çift tõklayõn.

Kiriş özellikleri (Beam properties) diyalog kutusundaki �profil� alanõnõ ZZ200-2-26*74-26*66 yazarak
doldurun (bir yandan gerekli şekli profil veri tabanõna eklerken, diğer yandan veri tabanõndaki Z profilini
kiriş özellikleri diyalog kutusuna getirmek için Select... tuşunu kullanõn.). OK tuşuna basõp aşõklarõ
modellemeye başlayõn.

Binanõn tepesine (B aks çizgisine en yakõn yere) 1 ve 2 no�lu aks çizgileri arasõna bir aşõk girin. Bu
aşõk�õn konumunun ve yönünün doğru olduğundan emin olmak için; 1 no�lu akstaki yan görünüşü
inceleyin.

Şimdide aşõklarõn sadece tepe sõrasõnõ tamamlayõn. (Aks 2�den 3�e, 3�ten 4�e ve 4�ten 5�e)

Aşõk ucunun çatõ kirişine bağlanmasõ

Makronun 8. sayfasõndaki Colled Rolled Sleeved macro (2) sunu kullanarak uç aşõklarõ aks 1�in
üzerindeki çatõ kirişine bağlayõn. Bu işlemde önce çatõ kirişini sonra aşõğõ seçin.

Makroyu yazõn ve picture (resimli) seçenek üzerinde �Cut distance of purlin� alanõna 200değerini
ekleyin.

Cleat seçeneği üzerinde cleat profili olarak UNP 160 kullanõn.
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İstenen cõvata mesafelerini Bolts formu üzerinde tanõmlayabilirsiniz.

Geri kalan aşõklarõn bağlanmasõ

Şimdide 2 no�lu aks üzerindeki çatõ kirişlerini aşõklara bağlayõn. Bunu yaparken önce çatõ kirişini,
ardõndan iki aşõğõ seçin ve sonrada fare orta tuşuna basõn.

Resimli seçenekleri kullanarak bağlantõnõn kollumu- kolsuzmu veya kollarõnõn
delikli mi- deliksiz mi olacağõnõ belirleyebilirsiniz

Eğer üst üste binen bağlantõ oluşturmak istiyorsanõz (üst üste gelen sac(1) )
aşõklardan ikincisinin �rotation� değerini �below�a değiştirmelisiniz. Bunu yapmak
için ikinci aşõğõ (Aks 2�den 3�e) seçin ve �rotation� değerini �below�a değiştirin. Ve
son aşõk (Aks 4�ten 5�e giden) için de aynõsõnõ yapõn.

Kalan bağlantõlarõ da ekleyip sonra bu bir sõra aşõğõ aşağõya doğru 5 kez
kopyalayõn.
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Çakõşma kontrolü

Son olarak Clash check komutunu kullanarak model içinde çakõşan herhangi bir parça ve cõvatanõn
olup olmadõğõnõ kontrol edin. Çakõşma kontrol komutu; birbiri ile çakõşan bölümlerin olup olmadõğõnõ
kontrol eder ve eğer çakõşma varsa bu çakõşan kõsõmlarõ sarõ renkte aydõnlatarak gösterir. Çakõşma
kontrolü birden fazla nesne seçildiğinde de pop-up menü ile yapõlõr. Bunun için :

1. Kontrol etmek istediğiniz nesneyi seçin.

2. Tools (araçlar) menüsünden (veya pop-up) Clash check komutunu seçin.
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Ders 4 � Eğitim 4

İlk önce çizim(ler)i ve aşağõdaki konularõ inceleyin
•  Yeni bir model başlatmak
•  Üç boyutlu görünüş oluşturmak
•  Aks çizgileri oluşturmak
•  Görünüş oluşturmak (Üç boyutlu, Plan ve Yan görünüşler)

Hopper Duvarlarõnõ Girmek

Hopper flanşõ

      Hopper flanşõ için çalõşma noktalarõ oluşturmak

      Flanş girilmesi

      Hopper flanş�a delik delmek
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Hopper Duvarlarõnõn Girilmesi

RL + 2.400 ve RL 0.000 kotundaki plan görünüşleri alt alta veya yan yana gelecek şekilde ekrana
yerleştirip üç boyutlu görünüşü de ekranõn sol üst köşesine koyun.

Contour Plate   makrosunu kullanarak RL+2.400 kotundaki plan görünüşte yer alan A-1 ve A-4 aks
kesişim noktalarõnõ seçin. Sonrada RL 0.000 kotundaki plan görünüşü üzerindeki B-3 ve B-2 aks kesişim
noktalarõnõ seçin. Şimdi tekrar RL +2.400 kotundaki plan görünüşte yer alan A-1 aks kesişim noktasõnõ
seçerek hopper duvarõnõ tamamlayõn.

Bu işlemi diğer üç duvar için de tekrarlayõn.

RL +2.400 kotu plan görünüşünde yer alan D-1 aks kesişim noktasõnõ yakõnlaştõrõn ve duvarlarõn
�middle� üzerine temellendirildiği için üst üste bindiğine ( iç içiçe  geçtiğine) dikkat edin. Duvarlardan
birinin üstüne çift tõklayõn ( Eğer Chamfer Properties diyalog  kutusunu açõk tutuyorsanõz üç boyutlu
görünüş üzerinde de duvarlara çift tõklamanõz gerekebilir.) ve Depth değerini �middle� dan �behind�a
çevirerek konumu ayarlayõn.

Bu işlemi diğer üç duvar için de tekrarlayõn.

Dikkat: bazõ görünüşlerde hopper duvarlarõndan bir kõsmõ  görünmeyebilir. Bu, plakalarõn ebatlarõndan
kaynaklanõr. Plan ve yan görünüşlerin alt ve üst derinliklerini 500�den 3000�e değiştirmeniz gerekecektir.

Dikkat:eğer plaka profillerinde PL veya PLT yerine FLT ön ekini kullanmak istiyorsanõz
....|countries|???|profil|profitab.inp  dosyasõna, PLT satõrõna benzer bir FLT satõrõ ekleyebilirsiniz.
Buradaki ??? ülkeye kullanõcõ  ortamõnõ temsil eder. (euro, uk,usimp, aus gibi)
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Hopper flanş

Hopper flanş için çalõşma noktalarõ oluşturmak

Noktalarõ, B aksõndaki yan görünüş üzerinde, hopper duvarõnõn dõş kenarlarõnõn +400 kotu ile kesiştiği
yere koyun.

Bu işlemi hem sol hem de sağ kenarlar için yapõn.

Bu işlemi C, 2 ve3 akslarõ üzerindeki yan görünüşlerde de yapõn.

RL +0.400 kotundaki plan görünüşe bakõn, burada az önce oluşturulan noktalarõ sarõ çarpõlar şeklinde
göreceksiniz.

Place point
here
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Create line line intersection point command komutunu kullanarak köşe noktalarõ oluşturun. Önce bir
yüzdeki noktalardan ikisini seçin sonrada komşu yüzlerden birinden iki nokta seçin.

Flanş girilmesi

Şimdi Beam Properties diyalog kutusunu kullanarak flanşlarõ girin.

Hopper flanşlara delikler delmek

Programõn kendi ara yüzleri ile hazõrlanan cõvata makrosunu kullanarak gösterilen delikleri ilave edin.

Construct these
corner points
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Ders 5 � Train 1  Güncelleme

İlk önce  Train 1   Modelini açõn

Merdiven için gerektiği sayõda nokta ve görünüşler oluşturulmasõ

Merdiven kirişlerinin girilmesi

Basamaklar için noktalar oluşturmak

Basamaklarõ girin, kaynaklayõn ve sonrada kopyalayõp çoğaltõn
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Merdivenler için gerektikçe noktalar ve görünüşler oluşturun

3200 kotundaki plan görünüşündeki  A ve 2 akslarõ kesişim noktalarõnõ yakõnlaştõrõn. Create Extension
Point ikonuna çift tõklayõn. �2000 �900 değerlerini girin. Apply�a basõn ve önce A3 aks kesişim noktasõnõ
ardõndan A2 kesişim noktasõnõ seçin.

Create Parallel Points ikonuna çift tõklayõn ve değeri 1200�e ayarlayõn. Az önce oluşturduğunuz iki
noktadan önce sağdakini ve sonra soldakini seçin.

Az önce oluşturduğunuz noktalarõ kullanarak ve aşağõda oklarla gösterilen yönleri dikkate alarak her
merdiven kirişi için bir yan görünüş oluşturun.

Şimdide merdiven sahanlõğõ için noktalar oluşturun.

 Diğer bir merdiven kirişi görünüşü üzerinde çalõşõrken bu kirişin tepesindeki noktanõn soluna doğru bir nokta
öteleyin (mesafe önemli değil), sonra saatin tersi yönünde 40 derece açõ ile bir nokta oluşturun.
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Şimdi Create line line intersection point  komutunu kullanarak, merdiven kirişinin tepesinde 40 derece açõ
ile duran iki nokta arasõndaki ve RL 0.0 kotundaki yatay aks üzerindeki iki nokta arasõndaki kesişimleri
bulun. Bu işlem, sol tarafta; merdiven kirişinin alt ucundaki noktayõ temsil eden bir nokta oluşturacaktõr.

Yukarõdaki nokta oluşturma işlemini ikinci merdiven kirişi için de tekrarlayõn veya eğer istiyorsanõz, bu işlemi;
yeni oluşturulan noktayõ diğer merdiven kirişine ait  görünüş üzerine kopyalayarak da gerçekleştirebilirsiniz.
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Merdiven kirişleri girilmesi

Şimdide merdiven kirişleri ve sahanlõk elemanlarõnõ girin (uygun U profillerini seçin) bunu yaparken
elemanlarõn doğru yere bastõğõna ve yönlerinin doğru olmasõna dikkat edin. bu elemanlarõn yerlerinin
doğruluğunu plan görünüşü üzerinde kontrol etmelisiniz.

Dikkat: U profillerini girerken yanlõş yönde girdiyseniz sakõn rotasyon değerini �below�a değiştirerek
düzeltmeye çalõşmayõn. Tüm yatay elemanlarõn rotasyon değerlerinin �top�a ayarlanmõş olmasõ gerekir  aksi
takdirde çizimlerde hepsi baş aşağõ detaylandõrõlõrlar .Bir U profilinin doğru yönde bastõğõndan emin olmak
için elemanlarõ soldan sağa girmek yerine sağdan sola girin.

Elemanlarõ girdikten hemen sonra merdiven kirişlerinin altõnõ Train 1 Update çizimi üzerindeki �Detail 1� de
gösterildiği gibi Line Cut komutunu kullanarak kesin.

Sonrada Fitting komutunu kullanarak merdiven kiriş başlõklarõnõ sahanlõk elemanlarõna tutturun. İlk önce
Fitting komut ikonuna tõklayõn, ardõndan hem sahanlõk hem de merdiven kiriş elemanlarõnõ seçim çerçevesi
içine alõp iki noktayõ aşağõdaki gibi seçin.

Şimdide merdiven kirişlerini sahanlõk elemanlarõna kaynaklayõn.

Sahanlõk elemanlarõnõ ana yapõya birleştirmek için makrolarõn altõncõ sayfasõndaki Shear Plate Simple (146)
makrosunu kullanõn.
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Basamaklar için noktalar oluşturun

Basamak için aşağõda gösterildiği gibi üç nokta oluşturun ve sonra merdiven kirişinin üst kõsmõna bir sonraki
basamağõn başlayacağõ yere gelecek şekilde bir nokta ilave edin.

2 3

1
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Basamaklarõ girin, kaynaklayõn ve kopyalayõp çoğaltõn

Create Holded Plate(bükümlü plaka oluştur)  komutunu kullanõp Folded Plate diyalog kutusunu
tamamlayõn. Profil olarak FPL10*900 kullanõn.

Şimdi daha önce �bükülmüş plaka� için oluşturulan üç noktayõ takip ederek bir bükülmüş plaka girelim.
Sonrada şekli tamamlayõp işlemi bitirmek için son nokta olarak başlangõç noktasõnõ seçelim.

Basamaklarõn doğru yerde konumlandõrõlmasõ için Position in Plane ve Position Depth değerlerini
ayarlamanõz gerekmektedir.

Şimdi basamağõn doğru yerde olduğundan emin olmak için plan görünüşünü kontrol edelim.

Basamak doğru yere oturtuldu ise onu her iki merdiven kirişine de kaynaklayõn (kaynaklarken önce
merdiven kirişini sonra basamağõ seçin ve sonra diğer merdiven kirişi ve basamağõ ...) ve Copy- Translate
komutunu kullanarak basamaklarõ gereken sayõda kopyalayõn ve çoğaltõn.
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Ders 6 � Train 5

İlk önce çizim(ler)i ve aşağõdaki konularõ inceleyin
•  Yeni bir model başlatmak
•  Üç boyutlu görünüş oluşturmak
•  Aks çizgileri oluşturmak
•  Görünüş oluşturmak (Plan ve Yan görünüşler)
•  Elemanlarõn girilmesi

Birleşim detayõ 1�in program arayüzleri kullanõlarak oluşturulmasõ

     Nervür plakalarõ

     Gövde birleştirme plakasõ

     Cõvatalar

Birleşim detayõ 2�nin program arayüzleri kullanõlarak oluşturulmasõ

     Uç hazõrlama şekli

     Nervür plakalarõ, gövde birleştirme plakasõ, cõvatalar
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Detay 1 Bağlantõsõnõ Program Arayüzü Kullanõlarak Oluşturun

Nervür Plakalarõ

6000 kotundaki plan görünüşü üzerinde fitting komutunu kullanarak, kirişi kolon flanşlarõndan 20 mm
geride kalacak şekilde budayõn.

Kirişin T.O.S. kotunda oluşturulan plan görünüşü üzerinde, üst nervür plakalarõnõ girmek için Beam
Properties diyalog kutusunu kullanõp köşe noktalarõnõ aşağõda gösterildiği gibi seçin. Nervür plakalarõnõ
doğru yere yerleştirmek için konum (position) altõndaki depth değerinde ve rotasyon (rotation)da gerekli
değişiklikleri yapõn.

Nervür plakalarõnõ kolona kaynaklayõn.
Şimdi bu nervür plakalarõnõ kirişin derinliği kadar aşağõya kopyalayõn.

Gövde birleştirme plakasõ

6000 kotundaki plan görünüşünde Create view by two points komutunu kullanarak kirişin gövde yüzü
boyunca bir yan görünüş oluşturun.

1. Nokta

2. Nokta
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Daha sonra çeşitli nokta oluşturma komutlarõnõ kullanarak gövde birleştirme plakasõ için gereken
noktalarõ oluşturalõm. İç köşelerdeki radyuslarõ göz ardõ ederek dikdörtgen köşeli bir gövde birleştirme
plakasõ oluşturun.

Contour plate makrosunu kullanarak gövde birleştirme plakasõ girin, bunu yaparken plakanõn yeterince
ortalandõğõndan emin olun.
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Gövde birleştirme plakasõnõn köşelerini yuvarlamak için radyusun ekleneceği köşedeki kesişen çizgiler
üzerine çift tõklayõn. Chamfer Properties diyalog kutusu belirmelidir.

Aşağõ açõlõr listedeki şekli içsel radyus olarak değiştirin. X değerine 11 girin ve modify tuşuna basõn. Bu
işlemi diğer köşeler içinde tekrarlayõn.

Şimdi gövde birleştirme plakasõnõ kolona kaynatõn.

Cõvatalar

Cõvatalar için gerekli noktalarõ oluşturun.

İnteraktif cõvata makrosu aracõlõğõyla diyalog kutusunu doldurup bunu uygulayõn ( Apply tuşuna basõn ).
Önce gövde birleştirme plakasõnõ seçin, sonra kirişi seçip fare orta tuşuna tõklayõp, ardõndan önce üst
sonra da alt cõvata noktasõnõ seçin.

Dikkat: İlk önce gövde birleştirme plakasõnõ ardõndan kirişi seçtiğinizden emin olun. Bu işlem kirişi sarõya
boyar ki; bu, elemana ait raporlarõn ve cõvata listelerinin oluşturulduğu anlamõna gelir.
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2 no.lu Birleşim Detayõnõn Program Arayüzleri Kullanõlarak
Oluşturulmasõ

Uç hazõrlama şekli

Kirişin sağ uç noktasõndaki uç hazõrlama şeklini oluşturmak için önce gerekli noktalarõ aşağõda
gösterildiği gibi oluşturun ve sonra kirişin ucunu kesip ayõrmak için Polygon Cut  komutunu kullanõn.

İç köşeleri yuvarlamak için köşe oluşturan çizgiler üzerine çift tõklayõp açõlan ekran üzerinde gereken
değişiklikleri yapõp buralarõ yarõçapõ 11 olan radyuslara değiştirin.
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Nervür plakasõ, Gövde birleştirme plakasõ, Cõvatalar

Contour Plate  makrosunu kullanõp 4 noktayõ aşağõda gösterildiği gibi seçerek üst nervür plakasõnõ
ekleyin.

Kolon gövdesindeki köşeleri 15x15 radyuslar haline getirin.

Nervür plakasõnõ kaynaklayõp aşağõ kopyalayõn.

Gövde birleştirme plakasõ için noktalar oluşturun. Contour Plate makrosunu kullanarak da plakalarõ
oluşturun.

Gövde birleştirme plakalarõnõ kolona kaynaklayõn.

Cõvatalar için noktalar oluşturup cõvatalarõ da yerlerine yerleştirin.

4.Nokta

2. Nokta

3. Nokta

1. Nokta
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Ders 7 � Train 6

Önce çizimleri ve aşağõdaki  konularõ inceleyin.
•  Yeni bir model başlatmak
•  Üç boyutlu görünüş oluşturmak
•  Aks çizgileri oluşturmak
•  Görünüşler oluşturmak ( Üç boyutlu,Plan ve Yan görünüşler)

Elemanlarõn Girilmesi

Makrolar Eklemek

    Kapalõ kesitlerin kolonlara birleştirilmesi 

    Ek yeri birleşim noktasõ

    Kapalõ kesitlerin birbirine sabitlenmesi

Kurt Ağzõ Kesim Şablonu (Wrap Around Template) Oluşturmak

Wrap Around = Profil gövdesine birleştirilecek bir diğer profil ağzõnõn oturma noktasõna göre kesimini
yapmak amacõyla profilin ağõz çevresinin iki boyutlu düzleme açõlõmõ.
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Elemanlarõn Girilmesi

Tüm kolonlarõ ve kapalõ kesit yuvarlak profilleri (boru) girin. Uç uca eklenen kapalõ kesit elemanlarõnõ
girerken bunlarõn iki ayrõ eleman olarak ayrõ ayrõ girildiğinden emin olun. Xsteel tek bir elemanõ iki ayrõ
parçaya bölme yeteneğine sahip değildir.
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Makrolarõn Eklenmesi

Kapalõ Kesit Profillerin Kolonlara Birleştirilmesi

İlk olarak sayfa 1�deki Endplate (29) makrosunu kullanarak kolondan üstteki Q160�lõk boruya bir birleşim
ekleyin. �General� sayfasõndan düğüm noktasõ �yukarõ� yönünü Z�ye çevirip kalan diğer bilgi girişlerini de
aşağõda verilenlere göre ayarlayõn.
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Dikkat: Eğer cõvata kenar payõ çarpanla büyütülmüş cõvata çapõndan daha küçükse ( Setup-
>Preferences...->Factor of bolt edge distance.) ana menüdeki mesaj alanõnda bir hata mesajõ (ve
�beep�) oluşacaktõr. Bu modelde minimum cõvata kenar mesafesi olarak cõvata çapõ 1.2 ile
büyütülmüştür. Eğer daha büyük bir değer kullanmak isterseniz (mesela 1.5) cõvata kontrolünü geçmek
için cõvata sayfasõnda gösterilen değerleri değiştirmeniz gerekir.

Şimdi de Save as kutusuna train_6 yazõn ve Save as düğmesine tõklayõn. Ayarlar bir kez kaydedildi mi
bunlarõ daha sonra kullanmak için tekrar geri yükleyebilirsiniz. Önce Apply sonrada OK tuşuna tõklayõn.
Şimdi kolonlarõn herbirini üst kõsõmdaki Q160�lõk borulara tek tek birleştirin.

End plate(29) makrosuna çift tõklayõn ve aşağõdaki başlõklar altõndaki değerleri değiştirin.
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Save as kutusuna  train_6_ lower  yazõn ve bu ayarlarõ kaydedin. Şimdide bu kolonlardan her birini alt
taraftaki Q 160�lõk standart borulara birleştirin.
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Ek yeri bağlantõsõ

Daha önce modellenmiş elemanlardaki eklerin her birini birleştirin. Ek yeri düğüm noktasõnõ oluşturmak
için makrolarõn dördüncü sayfasõndaki Joining Plates(14) makrosunu kullanõn. Aşağõdaki örneğe
uymasõ için her bir seçeneği doldurup OK düğmesine basõn ve elemanlarõ seçin.
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Kapalõ profilleri birbirine alõştõrmak

Kapalõ profillerde uçlarõn gövdelere bağlanmasõ gereken yerlerde uçlara kurtağzõ açmak için makrolarõn
ilk sayfasõndaki Roundtube(23) makrosunu kullanõn.

Dikkat: �yeterli boşluk bõrakmama� hatasõ yapmaktan kaçõnmak için resim sayfasõndaki gap
(boşluk,aralõk)  değerinin pozitif bir değere ayarlandõğõndan emin olun (mesela 0.5 veya 1.0 mm gibi).
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Wrap Around (Kurt Ağzõ Kesim) Şablonlarõ Oluşturmak

Herhangi bir çizime başlamadan önce modeli numaralandõrmalõyõz.

Tools çekme menüsünden Numbering - Full�u seçin.

Şimdi de Wrap Around şablonunu oluşturacağõnõz elemanõ aktif hale getirip Properties çekme
menüsüne gidin ve Single Part Drawing�i seçin.

�wrap_tp� ayarlarõnõ yükleyin ve OK tuşuna basõn.

Fare sağ tuşuna tõklayõn ve Wrap Around şablonu oluşturmak için  Single Part Drawing�i tõklayõn

Yandaki menüden Drawing List ikonunu seçip seçim listesini açõn. Buradaki çizimlerden açmak
istediğiniz bir tanesinin üzerine tõklayõn.
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Ders 8 � Train 7
Önce çizimleri ve aşağõdaki  konularõ inceleyin.

• Yeni bir model başlatmak
• Üç boyutlu görünüş oluşturmak
• Aks çizgileri oluşturmak
• Görünüşler oluşturmak ( Üç boyutlu,Plan ve Yan görünüşler)

Elemanlarõn Girilmesi

    Flanşlar

    Gövdeler

    Gövde berkitmeleri

Delikler Girmek

Tüm nervür plakalar FLT20*250 olacak ve iç köşeleri 30R radyuslu olacak.
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Elemanlarõ Girmek

Flanşlar

İlk önce plakalarõn yerlerini belirlemek için çalõşma noktalarõ oluşturun.

Nokta oluşturma araçlarõnõ kullanarak çalõşma noktalarõnõn yerlerini 1 no�lu aks üzerinde aşağõdaki
şekilde gösterildiği gibi belirleyin.

Flanşlarõ modellemek için Beam komutunu ve en son oluşturduğunuz noktalarõ kullanõn. Flanşlarõn
doğru yerleştirildiğinden emin olmak için Üç boyutlu görünüşü kontrol edin.

Kiriş Gövdesi

Kiriş gövdesi ve berkitme levhalarõ için Contour Plate komutunu kullanõn.

Üst ve alt flanşlarõ görüntülemek için zoomu kullanõn.
Şimdide alt flanş ve eğimli flanşõn kesişim noktasõnõ üstten görülecek şekilde yaklaştõrõn. Create line
line intersection point  aracõnõ kullanarak alt flanşlarõn üst yüzeylerinin kesişeceği yerde bir nokta
oluşturun.
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Flanşlarõn kiriş gövdeleriyle kesiştiği yer olan A aks çizgisinin 2000 mm sağõnda bir nokta oluşturun.

Şimdide contour plate komutu aracõlõğõyla, köşe noktalarõnõ ve az önce oluşturduğunuz noktalarõ
kullanarak iki adet gövde plakasõ oluşturun. Gövde plakalarõndaki farklõ et kalõnlõklarõna dikkat edin.
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Eğimli kiriş gövdesinin flanş köşeleriyle buluştuğu yerde eğimle duran alt flanşõ zoom ile yakõnlaştõrõp
gövde plakasõnõn köşe kesişimine çift tõklayõn.

Diğer köşe kesişimleri içinde aynõ işlemleri tekrarlayõn.

Şimdide Create line cut aracõlõğõyla bazõ flanş plakalarõnda pah�lõ kesim yapõn.

Aks 1 görünüşünde eğimli flanşõn düz flanşlardan üstte olanõ ile buluştuğu bölgeyi yakõnlaştõrõn. Create
extension point aracõlõğõyla flanş plakalarõnõn üst köşelerinden her iki yönde 20�şer mm mesafede
noktalar oluşturun.

Create line cut  ikonuna tõklayõp flanşlardan birini seçin. Sonra komut satõrõnõ izleyerek plakayõ pah�lõ
kesmek için iki nokta seçin.
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Gövde Berkitmeleri

1500 kotundaki  Plan görünüşünü açõn. Create parallel points tool aracõlõğõyla A aksõ boyunca bulunan
kiriş flanşõnõn köşelerinden 500�er mm mesafede noktalar oluşturun. (Şekle bakõnõz.)

Şimdi Create view by two points aracõlõğõyla az önce oluşturduğunuz iki noktayõ seçip (önce sol
sonrada sağ noktayõ) bir kesit görünüş oluşturun.

Create parallel points ikonuna çift tõklayõn ve iletişim kutusuna 250 girin. Kesit görünüşü üzerinden üst
ve alt flanşlarõn sağ yarõsõnõn gövde plakasõ ile buluştuğu yerdeki iki uç noktayõ Seçin (önce üstteki
sonrada alttaki noktayõ).
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Şimdide contour plate makrosunu ve az önce oluşturduğunuz noktalarõ kullanarak berkitmeleri
oluşturun.

Plakalarõn köşelerinden birini zoomlayõn (gövdenin flanşlarla buluştuğu yeri ). Köşe kesişim noktasõ
üzerinde aşağõdaki diyalog kutusunda gösterildiği gibi değişiklikler yapõn. Diğer
köşe kesişim noktalarõndada aynõnõ tekrarlayõn.

Yukarõdaki  işlemleri ve kopyalama komutunu kullanarak geri kalan plakalarõda oluşturun.

Dikkat: Diğer berkitmeleri yerleştirirken gövde et kalõnlõklarõnõn aynõ olmadõğõna dikkat edin. Yatay
berkitmeleri oluştururken 970 kotundaki plan görünüşünü kullanõn. Yatay berkitmelerin kalõnlõğõnõ 20
mm�ye ayarlayõn.

Şimdiye kadar oluşturduğumuz tüm parçalar birbirinden bağõmsõzdõ. Şimdi bu parçalarõ
asemblelere(birbirine bağlõ gruplara) dönüştürmek için birbirleriyle ilişkilendirelim. (Kaynak cõvata v.s. )
eğer aralarõnda hiçbir bağlantõ yoksa ayrõ ayrõ parçalarõn sadece çizimlerini oluşturabilirsiniz. Parçalarõ
Create weld  komutu ile birleştirin.   

Üç boyutlu görünüşten tüm parçalarõ görebileceğiniz bir noktayõ zoomlayõn. Create weld  ikonuna basõn.
Pick part to weld to (kendisine kaynaklanõlacak parçayõ seçin) sorusuna cevap olarak üst flanşõ seçin (
böylece üst flanş asemblenin ana parçasõ olacaktõr). Pick part to be welded sorusuna cevap olarak da
gövde plakalarõndan birini seçin. Aynõ komutla devam ederek önce üst flanşõ sonrada gövde plakasõnõ
seçin. Sağ tõklayõn ve Interrupt� õ seçin.   

Üst flanşõ seçip sağ tuşu tõklayõn ve Inquire -> Assembly�i seçin. Kõrmõzõ üst flanş ana parçadõr. Sarõ
renkteki gövde plakasõ ise bu assemble�nin tali parçasõdõr.

Tekrar Create weld  ikonuna tõklayarak alt flanşlarõ gövde plakalarõna ve sonrada birbirlerine
kaynaklayõn.

Tüm dikey berkitmeleri önce üst flanşa sonra gövde plakasõna ardõndan da alt flanşa kaynakla birleştirin.
Yatay berkitmeleri ise gövde plakalarõna kaynaklayõn.
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Dikkat: sakõn ana parçaya yanlõş yoldan herhangi bir şey kaynaklamayõn.

Tüm parçalar eklendikten sonra bunlardan herhangi birini seçin sonra sağ tõklayarak   Inquire-
>Assembly seçin. Üst flanşõ kõrmõzõ diğer parçalarõn tümünü sarõ renkte görmelisiniz.
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Delikler Eklemek

970 kotundaki plan görünüşünü açõn. Delikler için noktalar oluşturun.

Create bolt ikonuna çift tõklayõp açõlan iletişim kutusunu aşağõdakine göre doldurun.

OK tuşuna basõn. Pick part uyarõsõnõ alõnca berkitme plakasõnõ seçin ve seçimi girmek için fare  orta
tuşuna tõklayõn. Pick first / second position uyarõsõnõ alõnca noktalarõn her birini seçin.



                                                                                                              

Xsteel Eğitim Kursu                                                                                              Ders 9  � Modelleme Ortamõ Araçlarõ

 Copyright Tekla Oyj 2000,  Computers & Engineering 2002  Tel: 0049 6406 73667   www.comp-engineering.com        Page 9-1

CCCOOOMMMPPPUUUTTTEEERRRSSS   &&&
EEENNNGGGIIINNNEEEEEERRRIIINNNGGG

Ders 9 � Modelleme Ortamõ Araçlarõ

9. Ders modelleme ortamõnda mevcut komut ve araçlarõn kullanõmõ ile ilgili bir derstir. Eğitim modelini
tamamlama aşamasõna gelmemize rağmen bu araçlardan bir çoğuna hala değinmedik fakat bunlar çok
kullanõşlõ modelleme araçlarõdõr.

Faydalõ Modelleme Araçlarõ ve Komutlarõ

inşa çizgileri ve çemberleri

Yazdõrma

Nc-dstv

Sihirbaz

İçeri taşõ / Gönder

Veri tabanlarõ

Örnek alõnacak DGN modelleri

Düğüm noktasõ ana görünüşleri

Kõsmi temel görünüşler

Çalõşma alanõnõn seçilmesi

Kõsmi ilave

Proje özellikleri

Aşama numarasõ

Modelden kopyalama

Poligon (çokgen) şekiller çizmek

Cõvata parçalarõnõ yazdõrma
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Filtre seçimi

Anahtar seçimi

Otomatik kaydetmek

Pozlandõrma Ayarlarõ

Tercihler

Sõnõflandõrma renkleri

Yükle/Kaydet�in önceden tanõmlõlarõ

   Önceden tanõmlõ �kayõt� parametreleri

Önceden tanõmlõ �yükleme� parametreleri

Ölçmek

Numaralarõ kaldõrõ seç

İlk verilen markalar

Parça ve assemblilerin karşõlaştõrõlmasõ

Veri tabanõnõ kontrol et ve düzelt

    Veri tabanõnõ kontrol et

  Veri tabanõnõ düzelt

İşlem raporunu görüntüle

Tüm çizimin işlem raporunu görüntüle

Asemble araştõrmasõ

Kaynaklõ parçalarõ araştõrmak

Yardõm
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Konstrüksiyon  Çizgi ve Çemberleri

Konstrüksiyon çizgi ve çemberleri bir modelin geometrisini oluşturmak için kullanõlabilirler. Model içerisindeki
noktalar seçilerek oluşturulurlar ve nokta seçim araçlarõnõ kullanõrken diğer çizgiler gibi önceliklere sahiptirler.
Ekran sol menüsünde bunlara ait ikonlarõ bulabilirsiniz.

1. Construction lines seçilen herhangi üç boyutlu noktalar arasõnda oluşturulur.
2. Construction circles bir merkez nokta ve sonra çevre üzerinde bir nokta seçilerek oluşturulur.
3. İstenen çember çevresi üzerinde seçilen 'üç nokta da  �üç nokta ile çember inşasõ� nõ oluşturur.

İkiz (Çift) Profil

İkiz profil çift kirişler oluşturur. Profillerin tipi ve yönü Twin Profiles iletişim kutusundan tanõmlanõr.
Twin Profile ikonu sol ekran menüsündedir.

Bir başlangõç birde bitiş noktasõna tõklamakla ikiz profil oluşturulur.

Dikey Kiriş

Dikey kiriş aracõ çalõşma düzlemine dik bir kiriş oluşturur. Özellikleri ayarlamak için ikonun üzerine çift tõklayõn
ve properties iletişim kutusunu açõn.
Sol ekran menüsündeki ikona tõklayarak komutu başlatõn.

Model içinde bir nokta seçerek bir dikey kiriş oluşturun.

Yazdõrmak

Print komutuna File menüsündeki Print seçeneğinden girilir ve yazõ dosyalarõndan çõktõ almak için kullanõlõr.
Mesela Xsteel�den bir rapor gibi.

Print iletişim kutusunu açmak için Print komutunu seçin ve Browse�u kullanarak çõktõ almak istediğiniz
dosyayõ bulmak için göz gezdirin.
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Nc Files

Bu komut menülerden File->CNC->NC files yolu ile bulunabilir. Bu komut seçilen tüm parçalarõn NC
(Nümerik kontrol) dosyalarõnõ oluşturmayõ sağlar. Bu dosyalar otomasyon ekipmanlarõnõn çalõştõrõlmasõnda
kullanõlõr. Daha fazla bilgi için bilgisayar ekran yardõmõ dosyalarõnõ kullanabilirsiniz.

Sihirbaz

Sihirbaz kõsmi çizimlerin ve asemblilerin otomatik olarak üretiminde kullanõlõr.
Wizard ikonuna tõklayõp (Sol ekran menüsünden) iletişim kutusunu açõn.

Wizard kullanarak çizimler oluşturmak için:

1. Model içinden çizimlerini istediğiniz parçalarõ seçin.

Dikkat: Oluşturulan çizim dõşõnda bõrakõlacak kõsõmlarõn seçilip ayrõlabilmesi için Wizard içine
filtreleme seçeneği yerleştirilmiştir.

2. Wizard iletişim kutusundan oluşturmak istediğiniz çizim tipi için bir wizard ismi seçin.

3. Çizimi oluşturmak için Execute düğmesine basõnõz.
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İçeri taşõma / Dõşarõ gönderme

İmport/export fonksiyonlarõ bir modele bilgi çağõrma veya bir modelden bilgi göndermeye yarar. İmport
özelliği başka bir kaynaktan modelleri çağõrmaya yarar. Bunun yanõnda başka bir bilgisayarda oluşturulmuş
çizim dosyalarõnõ dahi çağõrabilir.

Export özelliği ise başka bir modelde veya bilgisayarda kullanõlmak üzere çalõşõlan modele ait bilgiler
gönderir.

İmport ve export ile ilgili daha fazla bilgi için Xsteel kullanõcõ kõlavuzuna veya bilgisayar ekran yardõmõna
başvurabilirsiniz.

Veri tabanlarõ

Database komutlarõ bir profilin, cõvatanõn, malzemenin ve yazõcõ veri tabanõnõn görüntülenmesi veya
yazdõrõlmasõnda kullanõlõr.

Database iletişim kutusunda değerleri değiştirerek veri tabanõna bilinen nesneleri ekleyebilirsiniz.
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Başvurulacak DGN Modelleri

Referans modeller Xsteel içinde arka plan resmi olarak kullanõlabilirler. Çağrõlan referans modeller düğmesi
açõk olduğu sürece görülebilirdir. Origin (başlangõç) noktalarõ her model için ayrõ ayrõ tarif edilebilir. Xsteel
Microstation DGN dosyalarõnõ referans dosyalar olarak okuyabilir. Aynõ anda birden çok referans model
açõlabilir. Referans modeller Xsteel modelleri ile beraber kaydedilemediğinden yüklenen her Xsteel modeli
için her seferinde ayrõ ayrõ açõlmalõdõr. Referans model üzerinde nokta seçmek mümkün değildir; ancak
serbest noktalara tõklanarak yaklaşõk değerler elde edilebilir. Komuta başlamak için üst ekran menüsünden
File->Reference...�i seçin.

     Başlõca Düğüm Noktasõ Görünüşleri

Bu komut seçilen düğüm noktasõna ait dört görünüş oluşturur. Çalõşma alanõ her yönde 1 metreye ayarlanõr.
Düğüm noktasõ temel görünüşleri her zaman tüm nesneleri görüntüler ve güncel görüntü özellikleri ayarlarõna
da bağlõ değildir. Kõsõmlar, cõvatalar ve delikler gerçek modlarõnda görüntülenir. Komutu başlatmak için ya
ekran menüsünden sõrasõyla View->Create view->Joint basic views  seçip ardõndan düğüm noktasõ
sembolünü seçin yada önce düğüm noktasõ  sembolünü seçip ardõndan fare sağ tuşunu tõklayarak hõzlõ
menüden ilgili komutu seçin. Bununla birlikte fare sağ tuşuna tõklayõp hõzlõ menüden Create view-> Basic
view komutunu seçerek birkaç düğüm noktasõnõn başlõca görünüşlerinin alõnabileceği bir perspektif görünüş
almak da mümkündür.
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Parça Temel Görünüşleri

Bu komut seçilen parçanõn dört temel görünüşünü verir. (Ön, üst, uç ve perspektif görünüşler) güncel görüntü
özellikleri kullanõlõr. Çalõşma alanõ seçilen kõsmõn çevresinde oluşturulur.
Komutu çalõştõrmak için ya ekran menüsünden View->Create view->Part basic views�i seçin yada fare sağ
tuşuna tõklayõp hõzlõ menüden ilgili komutu seçin.

Aynõ zamanda fare sağ tuşuna tõklayõp hõzlõ menüden Create view->Basic view komutunu seçerek seçili
birkaç parçanõn temel perspektif görünüşlerini elde etmek de mümkündür.

Çalõşma Alanõnõn Seçilmesi

Çalõşma alanõ; modelin görülebilir parçasõnõ tanõmlar.

Dikkat: Görüntü özellikleri aynõ zamanda görülebilirliği etkiler. (Ekran yardõmõ bölümünden görüntü
özelliklerini inceleyin.) Çalõşma alanõ ekranda yeşil kesik çizgilerden oluşan bir dikdörtgenle ifade edilir.

Pick work area komutu, modelden iki nokta seçerek çalõşma alanõnõn sõnõrlarõnõ belirlemeye yarar. Çalõşma
alanõnõ sõnõrlamak model üzerinde düzenlemeler yaparken hõzõ arttõrõr ve görüntü yenileme işini süratlendirir.
Bu komut özellikle geniş çaplõ modellerle çalõşõlõrken oldukça belirgin bir fayda sağlar. Fit work area  komutu
ise çalõşma alanõnõn genişletilmesinde kullanõlõr. Komutlardan her ikiside önce View seçilerek sonrada ekran
menüsünden komut seçilerek başlatõlõr.
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Parça Eklemek

Partadd komutu tali bir parçanõn ana parçanõn bir parçasõ haline getirilmesini sağlar. Partadd işlemi gerçekleştirilir
gerçekleştirilmez eklenen parçanõn tanõmõ da silinir.
Partadd komutuyla oluşturulan kombinasyon sadece tek bir işaret alõr. Eklenmiş parçalar magneta renktedir.

Partadd işlemi prefabrike elemanlarõn iş yerine vardõğõnda ana elemana birleştirilmesi gereken durumlarda
kullanõlabilir. Bu komutu ekran menüsündeki Detailing altõndan bulabilirsiniz.

Proje Özellikleri

Proje özellikleri kutusu Proje numarasõ, adõ, inşaatçõ firma v.b. gibi alanlardan oluşur. Bu alanlar bir çizim
şablonuna eklenebilir. Bu alanlar için önceden tanõmlanmõş değerler ...\system \standart .prf�den
değiştirilebilir. Project properties ekran menüsündeki Properties altõndan bulabilirsiniz.

     Faz Numarasõ

Bu iletişim kutusu mevcut nesnelerin faz�larõnda değişiklik yapmak için kullanõlõr.

Phase number iletişim kutusunu açmak için Properties -> Phase number�õ seçin.
Bir nesnenin faz numarasõ Inquire object iletişim kutusunda gösterilir.
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Aynõ asamblede bulunan parçalar aynõ faz numarasõna sahiptirler. Eğer bir düğüm noktasõ farklõ fazlardaki
parçalarõ birleştiriyorsa düğüm noktasõnõn parçalarõ farklõ asamble fazlarõna bölünür. Bir düğüm noktasõnõn
parçalarõ bağlõ bulunduklarõ ana parçanõn faz numarasõ ile gösterilirler. Bir asamblenin faz numarasõ
asambledeki ana parçanõn faz numarasõ ile aynõdõr.
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Modelden Kopyalama

Edit->Copy->From model komutu bir başka modelin özel fazlarõndan nesneler kopyalar. Bu komut bir model
üzerinde birden fazla kişinin çalõştõğõ durumlarda kullanõlabilir.

Copy from model iletişim kutusu yeni modele kopyalanacak model ve fazlarõ tanõmlamaya yarar. Bu kutu
Open model iletişim kutusuna çok benzer.
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Poligon (Çokgen ) Şekli Çizme

Bu komut bir contour plate  veya bir polybeam (çok köşeli kiriş)�in şeklini değiştirmekte kullanõlõr. Mevcut bir
contour plate şeklini değiştirmek için:

Mevcut çokgenin köşelerini seç (1)
Yeni poligonun köşe pozisyonlarõnõ seç (2,3)
Bir diğer mevcut poligon köşesi seç (4)
Ayrõlacak köşeyi tõkla (5)

Poligon şeklini modifiye etmek için drag (sürükle) ve drop (bõrak)�õ kullanmakda mümkündür:

Ayarlar (Setup) menüsünden Drag and drop komutunu seçin (veya D kõsa yol tuşunu kullanõn)
Köşe kesişim noktasõnõ harekete geçirmek için poligon köşelerini (1) seçin.
Aktif haldeki Köşe kesişim noktasõnõ seçip fare sağ tuşunu basõlõ tutarak Köşe kesişim noktasõnõ yeni
pozisyonuna taşõyõn sonrada tuşu serbest bõrakõn.
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Cõvata Parçalarõnõn Çizimi

Bu komut cõvatalarõ veya cõvata gruplarõyla birleştirilmiş parçalarõ ekler veya çõkarõr. Cõvata boyu otomatik
olarak ayarlanõr.

1. Ekran menüsünden Edit->Bolt parts�õ seçin.
2. Bir cõvata grubu seçin. Seçilen kõsõmlar parlayacaktõr.
3. Birleştirilecek kõsõmlarõ seçin. Fare orta tuşuna basarak seçilenleri girin.

Select Filter

Bu komut modeldeki seçilebilir nesneleri belirlemede kullanõlõr. Select (Seçim) özelliği aynõ zamanda select
switches (Seçim düğmeleri) ile de kontrol edilebilir. (Select switches (Seçim düğmeleri) ile ilgili bölümü
inceleyin.) iletişim kutusunu açmak için ya ikon üzerine çift tõklayõn veya sõrasõyla Setup->Select filter�õ
seçin.

Dikkat: Bir nesnenin seçilebilmesi için görülebilir olmasõ gerekir. Görülemeyen  nesneler görüntü filtreleri ile
filtre edilemez ve seçilemez.

Birleştirilen
parçalar

Birleştirilen
parçalar

Artan cõvata
boyu



                                                                                                              

Xsteel Eğitim Kursu  Ders 9  � Modelleme Ortamõ Araçlarõ

 Copyright Tekla Oyj 2000, Computers & Engineering 2002    Tel: 0049 6406 73667                                               Sayfa 9-13

CCCOOOMMMPPPUUUTTTEEERRRSSS   &&&
EEENNNGGGIIINNNEEEEEERRRIIINNNGGG

Daha önceden tanõmlanmõş filtreleri araç çubuğundaki aşağõ açõlõr menüden doğrudan seçebilirsiniz. Daha
önceden tanõmlanmõş filtreleri seçmenin diğer bir yolu da
Select filter iletişim kutusundan Load�õ  OK�lemektir.

Filtreleme anahtarlarõ yazõ alanlarõndan da girilebilir. Filtreleme anahtarõ bir model içerisinde bir parçayõ
tanõmlamak için kullanõlan kapsamlõ tariflerdir. Örneğin bir IPE 300 profili için IPE300 yazmanõz gerekir, ipe
300 yanlõş olur. Filtreleme özelliği filtering etiketi önündeki kontrol kutucuğu işaretlendiğinde devreye girer.
Not kutusu işaretlendiğinde ise kapsamlõ filtreleme devreye girer. Bir filtre alanõna birden fazla anahtar
girilebilir ve birden fazla filtre uygulanabilir. Filtreleme anahtarlarõ profil ismi IPE 300 gibi tam bir dizin olarak
temsil edilebilirler. Bunun yanõnda tamamlanmamõş bir dizin de olabilir. Mesela Profile alanõna IPE*
girildiğinde IPE ile başlayan tüm profiller seçilebilir hale gelir. Eğer bir çoklu anahtar kullanõlacak ise o zaman
dizinler boşluklarla ayrõlmalõdõr. (IPE* HE*)
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Seçim Anahtarlarõ

Sürekli görülebilir iki grup seçim düğmesi vardõr ; Seçim düğmeleri ve yakalama ayarlarõ. (Filtreyi seçin
Select filter bir önceki bölümde anlatõlmõştõr.)

Select (Seçim) Xsteel�in önceden tanõmlõ fonksiyondur. Sol üst köşedeki Cursor arrow fare imleci basõlõ ise
program seçim modundadõr.

Select switches seçme düğmeleri hangi nesne tiplerinin seçilebileceğini tanõmlamada kullanõlõr. Nesneler,
karşõlõk gelen düğmeye basõlõrsa seçilebilir. Select model objects  ve Select joint objects düğmeleri
hiyerarşide üst seviyelerdedir ve hangi nesne tipinin seçileceğini tanõmlarlar

. Modify (değişiklik yap), remove (ayõr) ve copy (kopya) gibi Xsteel�e ait tüm komutlar, nokta, parça ve
pencere gibi seçilen parçalarõ etkiler. Bir nesne seçildiğinde parlar ve bir pencere seçildiğinde de kõrmõzõ bir
çizgi ile çevrelenir.

Dikkat: Komutlarõn iptali için fare sağ tuşu ile hõzlõ menüyü açõn ve Interrupt�õ seçin. Komutlar aynõ zamanda
ESC tuşu veya Cursor ikonuyla da iptal edilebilir.
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Otomatik Kayõt

Bu komut otomatik kayõt aralõklarõnõ belirler. Modelleme fonksiyonlarõ ve interaktif çizim oluşturma ile otomatik
çizim için ayrõ ayrõ ve farklõ zaman aralõklarõ tanõmlanabilir. Modelleme ve interaktif çizim oluşturma işlemleri
için belirlenen zaman aralõğõ; her iki kayõt arasõnda gereken menü komut sayõsõ kadardõr. Model ve Drawing
önündeki kontrol kutucuğundaki işaret Autosave özelliğinin seçili fonksiyon için aktif olup olmadõğõnõ kontrol
eder. Setup->Autosave ...�i seçerek bu iletişim kutusunu açõn.

 Numaralama Ayarlarõ

Numbering setup iletişim kutusu modeldeki parçalarõn nasõl numaralandõğõnõ kontol eder. Numbering setup
iletişim kutusunu Setup->Numbering...

komutlarõnõ seçerek açõn. Bu form; numaralama seçeneklerini ve �benzer parçalarõn numaralandõrõlmasõ� ile
ilgili olarak parçalarõn nasõl karşõlaştõrõldõklarõnõ içerir. Numbering setup iletişim kutusu ile ilgili daha fazla
bilgi almak için Xsteel yardõm dosyalarõna başvurur.
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Tercihler

Preferences iletişim kutusu modelde kullanõlacak bazõ önceden tanõmlõ değerleri ayarlamaya yarar. Setup-
>Preferences�i seçerek Preferences iletişim kutusunu açõn.
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Sõnõfa Göre Renklendirme

Aşağõ açõlõr Setup menüsünden Color by class�õ seçmek modeldeki nesnelere renkler atar. Class, nesne
özellikleri iletişim kutusunda sayõlardan oluşan bir settir ve model içinde renklerle temsil edilir. Class atamasõ;
nesne üzerinde yapõlmak istenen değişikliklerin daha hassas olabilmesi amacõyla nesnenin ileri bir tarifi
olarak da kabul edilebilir. Nesneler class aracõlõğõyla filtre edilebilir veya seçilebilir.

Aşağõda tablo class lar için nelerin kullanõlabileceğine ilişkin tavsiyelerdir.
CLASS RENK KULLANILAN ELEMAN
1 beyaz Koniler,özel not konmuş elemanlar( yani momentler,eksenel parçalar)
2 kõrmõzõ ***KULLANMAYIN***
3 yeşil Kirişler,aşõklar,makaslar
4 mavi Çeşitli(düğüm noktalarõ,çevre ölçüleri,eğilme halatlarõ,korkuluklar,v.s.) herhangi bir �boşluklu�

eleman.
5 Cyan Çaprazlar (düşey veya yatay) ; merdiven basamaklarõ ; gömülü parçalar.
6 Sarõ ***KULLANMAYIN***
7 Magenta Kolonlar,direkler ve askõlar
99 beyaz Tüm birleşim elemanlarõ için standarttõr.

KIRMIZI veya SARI  kullanõlmamasõ tavsiye edilir. Çünkü bu renkler Xsteel tarafõndan bazõ işlemler
yapõlõrken ilgili parçalarõn tanõmlanmasõnda kullanõlõr. Ancak class�larõ dilediğiniz şekilde atayabilirsiniz.



                                                                                                              

Xsteel Eğitim Kursu  Ders 9  � Modelleme Ortamõ Araçlarõ

 Copyright Tekla Oyj 2000, Computers & Engineering 2002    Tel: 0049 6406 73667                                               Sayfa 9-18

CCCOOOMMMPPPUUUTTTEEERRRSSS   &&&
EEENNNGGGIIINNNEEEEEERRRIIINNNGGG

Tanõmlanmõşlarõ Yükle / Kaydet

       Tanõmlanmõşlarõ Kaydet

Bu komut özellikler iletişim kutusundaki en güncel ayarlarõ, iletişim kutusunun bir sonraki çağrõlõşõnda veya
başka bir oturumda kullanõlmak üzere kaydeder. Normal olarak önceden tanõmlõ bu değerleri �standart� adõ ile
kaydedersiniz.

Tanõmlanmõşlarõ Yükle

Bu komut daha önceden kaydedilmiş ayarlarõ özellikler iletişim kutusuna yükler. Programõn başlangõcõnda bu
komut kendiliğinden istenir.

UC310*97

300PLUS
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Ölçü

Ölçü komutu model üzerindeki noktalarõ yakalayarak geçici ölçüler oluşturur. Görüntü bir kez zoom, pan,
redraw veya güncelleme işlemine tabi tutulunca ölçüler kaybolur.

Ölçü komutlarõ ölçü ikonlarõndan biri seçilerek veya menüden Tools->Measure-> seçilerek başlatõlabilir.

Aşağõ açõlõr tools menüsünden iki ilave seçim yapmak mümkündür. Angle ölçüsü açõlarõn derecelerini
ölçmekte kullanõlõr. Buna ek olarak bir Bolt ölçü aracõ seçilen kõsõm üzerinde bir cõvata yerleşimini
ölçülendirir.

Numaralarõ Kaldõr

Bu komuta araçlar menüsünden Tools->Numbering->Unnumber selected zinciri ile ulaşõlabilir. Parçalarõ ve
asambleleri seçip komutu çalõştõrdõğõnõzda seçilen parçalar üzerindeki numaralar kaldõrõlõr. Parçalar daha
sonra üzerlerinde hiç numara yokmuş gibi tekrar numaralandõrõlabilirler.     
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Ön Markalama

Preliminary mark komutu kolon ve kirişlere, raporlarda kullanõlmak üzere bir ön markalama yapar. Bu ön
markalarõ aynõ pozisyon ve parça numarasõna sahip parçalarõn gruplandõrõlmasõnda kullanabilirsiniz. İnquire
object komutunu kullanarak elemanõn ön markasõnõ kontrol edebilirsiniz. Bu komuta Tools->Numbering->
Preliminary mark zincirinden ulaşabilirsiniz.
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Parça ve Asembleleri Karşõlaştõr

Bu komut herhangi iki asambleyi veya iki parçayõ karşõlaştõrõp aynõ mõ yoksa farklõmõ olduklarõnõ anlamakta
kullanõlõr. Bu komutu kullanmak için sadece karşõlaştõrõlacak iki nesneyi seçin. Eğer ikiden az yada fazla
nesne seçerseniz Xsteel size uyarõ mesajõ verir. Asambleleri karşõlaştõrõrken asambleyi tanõmlamak için
herhangi bir parçasõ seçilebilir. Karşõlaştõrmanõn sonuçlarõ ekranõn üst kõsmõndaki komut satõrõnda yazõlõr.
Komutu başlatmak için Tools->Compare->Assemblies zincirini kullanõn.
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Veri tabanõnõn Kontrolü / Düzeltilmesi

Aşağõdaki komutlardan her ikiside Tools aşağõ açõlõr menüsünden bulunabilir.

Veri tabanõnõn Kontrolü
Check database veri tabanõ üzerinde bir bütünlük kontrolü yapar. Eğer bir uyumsuzluk varsa komut satõrõnda
bunu bildiren bir mesaj belirir.

Veri tabanõnõn Düzeltilmesi
Correct database veritabanõnõ gözden geçirir; buna ek olarak bulduğu herhangi bir uyumsuzluğu düzeltir.
Tüm düzeltmelerin yapõlmasõ için Correct database�i birkaç kez çalõştõrmanõz gerekecektir. Nihayetinde
sonuçlarõn kontrolü için Check Database�i çalõştõrmalõsõnõz.

 Dikkat: Modelleme yaparken veritabanõ kontrolünü günlük yapmak iyi bir pratiktir. Bu pratik birden çok
kullanõcõ ile hazõrlanan modellerde oldukça faydalõdõr. Check-database/Correct database geniş çaplõ veri
tabanõ hatalarõnõn yapõlmasõnõ engeller.

Seyir Dosyasõnõn Görüntülenmesi (Display Log file)

Bu komut tüm modelleme oturumu boyunca yapõlan işlemlerin seyrini görüntüler.
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Çizimin kronolojik Seyri

Bu komut tüm çizimlerin seyrini tarihleri ile beraber verir. Tools->Drawing history log�u seçerek
görüntüleyin.

Asemble Soruştur

Model içerisinde bir asemblenin herhangi bir parçasõnõ seçin. Aşağõ açõlõr Inquire  menüsünden Inquire
assembly�i seçin. (Veya hõzlõ menüden seçmek için sağ tuşla tõklayõn.) bu işlem ile tüm asamble
parlayacaktõr. Ana parçalar KIRMIZI ile tüm tali parçalarda SARI  ile gösterilir.
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 Kaynaklõ Kõsõmlarõ Soruştur

Tali bir parçayõ seçip Inguire->welded parts->to zincirini seçerseniz kaynaklanmõş kõsõmlar aktif hale
gelecektir.
Herhangi bir parçayõ seçip Inguire->welded parts->all zincirini takip ettiğiniz takdirde kaynaklõ tüm kõsõmlar
aktif hale gelir, parlar.

Yardõm
Modellemede olsun çizimde olsun herhangi bir problemle karşõlaştõğõnõzda başvurabileceğiniz en iyi
kaynaklardan biri help  dosyalarõdõr. Makro yardõm dosyalarõ bu makrolarõn ne için kullanõldõğõnõ ve nasõl
çalõştõrõldõğõnõ öğrenmek için oldukça faydalõdõr.
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Ders 10 � Train 8

İlk önce çizimleri ve aşağõdaki konularõ inceleyin.
•  Yeni bir modele başlangõç
•  Üç boyutlu görünüş oluşturmak
•  Aks çizgilerini oluşturmak
•  Görünüşler oluşturmak (plan ve yandan görünüşler)

Elemanlarõ Girin

Numaralandõrma ve Tamamlanmõş otomatik kontrol Listesi

     Numaralandõrma

    Otomatik kontrol raporlarõ

    Taslaktan itibaren numaralandõrmaya başlamak

    Kontrol listesinin otomatik olarak gözden geçirilmesi

Asamble çizimi oluşturmak   

    Asamble çizimlerinin el ile oluşturulmasõ

    Asamble çizimlerinin sihirbaz kullanõlarak oluşturulmasõ

    Tekil  kõsmi çizimlerin oluşturulmasõ (Sayfaya Sõğdõrarak)

Genel düzenlemeler için çizimlerin oluşturulmasõ (Planlarõn Markalanmasõ)
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HE400A

S235JR

Elemanlarõ Girin

Herhangi bir eleman girmeden önce modeli yapõlacak işe ait özel bilgiler girerek ayarlamamõz
gerekmektedir. Bunun için sayfadaki Model ayarlama bilgilerine göz atõn.

Tipik cõvata cinsi:                                                                           6914

Asamble markalama ön ekleri:                  
                                                                                                      B      -     Kirişler
                                                                                                      C      -     Kolonlar
                                                                                                      BR   -     Çaprazlar
                                                                                                      R      -     Aşõk Kirişleri
                                                                                                      T      -     Makaslar
                                                                                                      P      -     Aşõklar

Asamble Markalama Başlangõç Numarasõ:                       100

Ana şaftlar için parça markalama ön ekleri:                       M

Sabitleme elemanlarõ için parça markalama ön ekleri:      P

Parça markalama ön ekleri:                                              100

Kullanõlacak parçalarõn adlarõ ve sõnõflarõ:

                         Adlarõ                     Sõnõflarõ

                     KİRİŞ                            2
                     KOLON                        1
                     YATAY ÇAPRAZ         3
                     DÜŞEY ÇAPRAZ         4
                     AŞIK KİRİŞİ                 5   
                     MAKAS                        6
                     AŞIK                             7

�Eleman girişi� iletişim kutularõnõn  her birine
girerek (kiriş özellikleri, kolon özellikleri, kontur
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plaka, bükülmüş plaka v.s.) her birini
yukarõdaki bilgilere göre ayarlayõp sonra
uygulayõn.

Setup çekme menüsünden Preferences�i seçin.

Bağlantõ cõvatasõ standartlarõnõ 6914�e çevirin. Düğüm noktasõ parça malzemesini S235JR�ye ve son
dört seçeneği p\100�e çevirerek Apply tuşuna basõn. Aşağõyõ inceleyin.

Setup çekme menüsünden Save Defaults�õ seçerek bu ayarlarõ modelin ileriki aşamalarõnda kullanmak
üzere kaydedin.
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Dikkat: Elemanlarõ girerken bu elemana ait iletişim kutusunun doğru doldurulduğundan emin olmak için
iki kez kontrol ediniz. Örneğin;önceden tanõmlõ olarak seçtiğiniz her  Parça numarasõ, Asamble
numarasõ, Marka başlangõç numaralarõ,İsim, Malzeme ve Sõnõfõ inceleyin. .
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Proje Özellikleri

Proje özellikleri tüm çizimler için ortaktõr ve başlõklardan oluşan yazõ kutucuklarõnõ gerekli bilgilerle
doldurup kullanabilirsiniz. Proje özellikleri iletişim kutusunu açmak için ekranõn üst kõsmõndaki çekme
menüden Properties->Project�i seçin.
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Numaralandõrma ve Tam Kontrol Listesinin Otomatik Kontrolü

 Numaralandõrma

Modelleme işlemi tamamlandõğõnda (Yani tüm bağlantõlar da eklenip çakõşma kontrolleri de yapõldõktan
sonra ) modeldeki belli başlõ bazõ hatalarõ otomatik olarak gözden geçirmek için Xsteel�e ait bazõ
raporlarõ çalõştõrmamõz gerekir.

Herhangi bir rapor çalõştõrma veya çizim oluşturma işlemini yapmadan önce modelde
numaralandõrmalarõ yapmalõyõz ki, Xsteel her elemana bir marka atayabilsin.

Çekme Setup menüsünden  Numbering�i seçin.  Numbering Setup iletişim kutusunu kontrol edin.
Numbering setup iletişim kutusundaki işlemlerin açõklamalarõ için Xsteel Yardõm dosyalarõna başvurun:

Bunun için Modeling->Setup->Numbering  zincirini takip edin.

Şimdilik önceden tanõmlõ değerleri kabul etmek için OK�ye basalõm.

Eğer modelde Tools çekme menüsü yardõmõyla numaralandõrma yapmak istiyorsanõz Numbering-
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Full�u seçin. Bu işlem modeldeki tüm parçalarõ numaralandõracaktõr.

Otomatik Kontrol Raporlarõ

Otomatik kontrol raporlarõnõ çalõştõrmak için ekranõn üst kõsmõndaki Report ikonunu seçin, mevcut
listeden rapor türünü seçin ve All Parts tuşuna tõklayõn. raporlarõ görüntülemek için de Show düğmesine
basõn. (Bir sonraki sayfada bulunan rapor listesine göz atõn.)
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Bir sonraki sayfada bulunan Self- Checking Checklist adõmlarõnõ izleyin ve modelde gerekli değişiklikleri
yapõn. Modelin tekrar gözden geçirilmesi gerekiyorsa modeli tekrardan numaralamanõz gerekecektir.
Tools çekme menüsünden Numbering-> Full�u seçin. Şimdi diğer hatalarõ da görmek için raporlarõ
tekrardan çalõştõrõn.  

Bu raporlara ek olarak, Çizimi oluşturmadan önce herhangi bir problemi varsa açõğa çõkarmak için Self-
checking Checklist�de ( Otomatik kontrol kontrol listesi) gösterilen görsel kontrolleri yapõn.

Dikkat: Model üzerinde yaptõğõnõz herhangi bir değişiklikten sonra numaralandõrmayõ yeniden yapmanõz
gerekmektedir.

İlk Taslaktan İtibaren Numaralandõrmaya Başlamak

Numaralamayõ tamamlayõp perçinlemediğiniz sürece (Çizimlerin çõktõsõnõ alarak veya çalõşma alanõna
göndererek) numara verme işlemine en başõndan başlayabilirsiniz.

Tüm modeli seçmek (hem nesneleri hem de bağlantõ noktasõ nesneleri) için Pick Tools->Numbering-
>Unnumber selected zincirini takip edin. Unnumber selected komutu seçilen parçalar ve assemlelerdeki
numaralarõ kaldõrõr. Daha sonra bu parçalar daha önce hiç numaralandõrõlmamõşlar gibi yeniden
numaralandõrõlõrlar.

Daha sonra Renumber all ayarlarõnõ kullanarak modeli yeniden numaralandõrõn.     

Numaralandõrmaya başlamadan önce başlangõçtaki numaralandõrma ayarlarõna geri dönmeyi
unutmayõn.
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Uyarõ: Unnumber selected komutunu veya Renumber all ayarlarõnõ kullandõğõnõzda önceki
numaralandõrma işlemine ait tüm bilgileri kaybedersiniz. Bu ayarlar dolayõsõyla sadece projeye başlarken
güvenli bir şekilde kullanõlabilirler
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Otomatik Kontrol Kontrol Listesi

•  Asamble_ listesi-  Numaralandõrma sõnõrlarõnõ kontrol et.

•  Asamble _ listesi � Ana parça profilini kontrol et.( Plakalar veya yassõlõklar yanlõş kaynaklamaya
işaret edebilirler.)

•  Parça _listesi � Çelik cinslerini kontrol et.

•  Parça _listesi � Plaka kalõnlõklarõnda olasõ anormallikleri kontrol et.

•  Parça _listesi � Numaralandõrma aralõğõnõ kontrol et.

•  Parça _listesi � Malzemelerin sõfõr uzunluklarõnõ kontrol et.

•  Cõvata_listesi � Rondela tiplerini ve sayõsõnõ kontrol et.

•  Tüm modelde çakõşma kontrolü yap. (taban sabitleme plakalarõnõ filtre etmeden)

•  Gövde birleştirme plakalarõnõn doğru tarafta olup olmadõklarõnõ kontrol et. Kuzey ve Batõ gibi.

•  Çelik yapõnõn inşa edilebilirliğini kontrol et.

•  Görüntü filtresi özelliğini kullanarak kirişlerin kiriş, kolonlarõn da kolon olarak adlandõrõlmõş olmasõna
dikkat et.

•  Asamble çizimlerini ve birleştirme levhalarõnõ belli başlõ anormalliklere karşõ görüntüle.

•  Markalama planõ üzerinde markalarõn varlõğõnõ kontrol edin ve marka güncellemesinin yapõlõp
yapõlmadõğõnõ kontrol edin.

•  Her çizim üzerindeki başlõk kutusu içindeki bilgilerin doğruluğunu kontrol edin.
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Asamble Çizimlerini Oluştur

Asamble Çizimlerinin El İle Çizilmesi

İlk olarak kirişlerin asamble çizimlerini yapacağõz.

Görüntü filtresini kullanarak sadece kirişleri görülebilir yapõn.(Üst/Alt durum harflerine dikkat edin.)

Bu kirişleri fareyi üzerlerinde sürükleyip seçin ve aktif hale getirin.

Özellikler (Properties) çekme menüsüne gidin ve Assembly drawing�i seçin.

Kirişin önceden tanõmlõ değerlerini kabul edin ve uygulayõn.

Drawing çekme menüsünden  Assembly Drawing�i seçerek çizimi oluşturun.

Şimdi tekrar görüntü filtrenizi kullanarak sadece kolonlarõ görülebilir hale getirin. Bunlarõ seçip �column�
asamble çizimi için önceden tanõmlõ değerlerini kabul edin. Bunlarõ Apply edip Drawing çekme
menüsünden Assembly Drawing�i seçerek kolon çizimini oluşturun.
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Bu işlemi tüm eleman türleri için tekrarlayõn.

Tüm asamble çizimlerini bitirdikten sonra herhangi birinin unutulmamõş olduğunu kontrol etmeniz
gerekir.
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Görüntü filtrenizi kullanarak şimdi tüm çizdiklerinizi tekrar görünür hale getirin.

Properties çekme menüsü altõndaki Assembly Drawing Properties iletişim kutusuna gidin ve isim
�Name� hanesine NOT DRAWN yazõn.

Bunu uygulayõn, bütün elemanlarõ aktif hale getirerek tüm modeli seçin ve Drawing çekme menüsünden
Assembly Drawing�i seçin.

Bu işlem sadece şu ana kadar detaylandõrõlmamõş asambleleri detaylandõracaktõr. Eğer çizimler bu
adõmda oluşturulmuş ise çizim listesinde NOT DRAWN olarak belireceklerdir. Bu çizimleri iptal ettikten
sonra, doğru �asamble çizimi� sunumunu yükleyerek bu çizimleri yeniden oluşturmanõz gerekecektir.

Asamble Çizimlerini Sihirbaz Yardõmõyla Oluşturmak

Bu sihirbaz çizimlerin oluşturulmasõnõ hõzlandõrmak için geliştirilmiştir.

Çizim listesini açõn ve oluşturduğumuz tüm çizimleri silin. Şimdide tüm elemanlarõ içine alacak şekilde
modelin tamamõnõ seçin.

File çekme menüsünden Wizard�õ seçin.

Önce auto_ drawings�i seçin ve sonrada Create�i...

Sihirbaz, otomatik olarak her eleman tipi için elemanõn parça adõnõ esas alõp doğru asamble çizimi
sunumunu kullanarak çizimleri oluşturur. Eğer eleman BEAM olarak adlandõrõlmõşsa eleman Beam
sunumu kullanõlarak detaylandõrõlõr. Eğer COLUMN olarak adlandõrõlmõşsa bu kez kolon sunumu
kullanõlarak detaylandõrõlõr.

Tekil Parça Çizimi Oluşturulmasõ (Sayfaya Sõğdõrarak)

Normalde tekil parça çizimleri (sayfaya sõğdõrarak) sadece uç plakalarõ, taban plakalarõ, cleatler, raptiye
köşebentleri v.s.�ler için oluşturulur, ana parçalar için değil.

Bu model için sadece parça markasõ ön ek�i p olan nesneler için tekil parça çizimini oluşturacağõz.

Görüntü filtresini kullanõn ve sadece bu nesneyi görüntülemek için View Filter iletişim kutusundaki Part
Position alanõna p* yazõn.
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Şimdi tüm modeli pencere içine alarak tüm sabitleme elemanlarõnõ aktif hale getirin ve single_draw
sihirbazõnõ çalõştõrõn.
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GA (Genel Düzenlemeler) Çizimlerini Oluşturmak (Markalama Planõ)

GA çizimleri Xsteel tarafõndan otomatik olarak oluşturulmazlar. İlk önce model üzerinde yakalayõp almak
istediğimiz kõsmõn görünüşünü oluşturmalõyõz, sonra üzerinde sadece başlõk blok�u bulunan boş bir çizim
sayfasõ oluşturup, daha sonra bu boş sayfayõ açarak model görünüşünü üzerine eklemeliyiz.

Oluşturacağõmõz ilk görünüş perspektif görünüştür, bu yüzden ekrana 3-d görünüşü çağõrõn.

Properties çekme menüsünden General Arrangement Drawing�i seçin.

Bunu A3- Blank (Boş A3) genel düzenlemeler çizim (General Arrangement Drawing) sayfasõna yükleyip
önce Apply�a sonrada OK�ye basõn.

Şimdide Drawing çekme menüsünden General Arrangement�i seçin. Bu işlem boş bir A3General
Arrangement  çizim sayfasõ oluşturacaktõr.

Bu çizimi açmak istediğinizde sol ekran menüsünden Drawing List ikonunu seçip çizim üzerine çift
tõklayõn. Dikkat:  Xsteel tarafõndan G[1] diye adlandõrõlmõştõr.

Bu boş çizim sayfasõ üzerine Perspektif görünüşü eklemek için ekranõn solundaki Create view from
model ikonuna çift tõklayõn.

PERSP ayarlarõnõ yükleyip önce Apply tuşuna sonrada OK tuşuna basõn.

Şimdi üç boyutlu perspektif model görünüşüne gidip fare sol tuşuna basarak 3d görünüşü  çizime
ekleyin.

Görünüş bir kez eklendiğinde fare sağ tuşunu klikleyip Place Views komutunu kullanarak görünüş
merkezleyebilirsiniz.
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     Ders 11 � Çizim ve Yazdõrma Egzersizleri

Plan ve Yan Görünüşlerin Oluşturulmasõ

�Genel Düzenlemeler� Çizimlerinin Ölçülendirilmesi

Aşõk Kirişleri Planõna Detaylarõn Eklenmesi

Ankraj Cõvatasõ Planõnõn Oluşturulmasõ

Makas Çiziminin A1 Çizim Kağõdõna Sõğdõrõlmasõ

Makas Çizim Ölçülerinde Değişiklikler Yapõlmasõ
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Plan ve Yan Görünüşleri Oluşturun

Eğitim 8 modelini açõn.
Aşağõdaki GA çizimlerini oluşturmak için 10. derste anlatõlan açõklamalarõ inceleyin:

• 6500 kotundaki Plan Görünüşünden Çatõ Planõnõ
• 3000 kotundaki Plan Görünüşünden Kat Planõnõ
• FFL  kotundaki Plan Görünüşünden Ankraj Cõvata Planõnõ
• 6500 kotundaki Plan Görünüşünden Aşõk Kirişlerini Filtre Ederek Aşõk Planõnõ

Yan  görünüşler:

• A Aksõ
• B Aksõ
• C Aksõ
• 1 No�lu Aks
• 4 No�lu Aks
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GA  Çizimlerinin Ölçülendirilmesi

Roof  Plan�a (çatõ planõna) ait  GA çizimini açõn. Ölçü verilecek ilk şeyler akslardõr. Bu işlem Create x
dimension veya Create y dimension ikonlarõnõ kullanõp el ile takip ederek yapõlabilir, fakat bunu
yapmanõn daha etkili bir yolu çekme Create menüsüne gidip (ekranõn üst kõsmõnda) Pick view
komutundaki Dimension->Grid�i seçerek çizim görünüşüne tõklamaktõr. Bu işlem aks çizgilerini otomatik
olarak ölçülendirir. Gereken diğer ölçülendirmeleri elle yapmak için ölçülendirme araçlarõnõ kullanõn.

Geri kalan GA çizimlerine gidip onlarõ da Eğitim Modelleri Kitapçõğõndaki çizimler üzerinde gösterildiği
şekilde ölçülendirin.
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Aşõk Kirişleri Planõna Detaylar Ekleyin

Şimdi görüntüyü temizleyip aşõk kirişleri planõna birkaç detay ekleyeceğiz.
Rafter Plan (aşõk kirişleri plan) çizimini açõn.
Görüntü özellikleri iletişim kutusunu açmak için mavi sõnõr çizgisine çift tõklayõn.
Filter tuşunu tõklayõn.
İletişim kutusunu aşağõdaki gibi doldurun ve Modify tuşuna basõn.

Bu işlem Part name�de listelenen parçalarõ filtre eder ve aşõk kirişi görünüşünden siler.

A/1 akslarõnõn kesiştiği noktaya yakõn bir bölgeyi zoomlayõn.
Create view from view  ikonuna tõklayõn.
A ve 1 akslarõ tarafõndan oluşturulan sol üstteki çeyrek içinden bir nokta seçin.

Şimdi aşõk kirişi planõnõn sol alt kõsmõnda bir detay görünecektir.
Bu detayõn koyu mavi sõnõr çizgisine çift tõklayõn. ölçeği 1/25.0000�e değiştirip Modify tuşuna basõn. Bu
işlem detayõn ölçeğini büyütür.

Shift düğmesine basõn ve basõlõ tutarken detayõn mavi çizgisi üzerine tõklayõn, bu şekilde detayõ çizim
içerisinde istediğiniz bir yere sürükleyerek konumunu değiştirebilirsiniz. ( Dersin başlangõcõndaki Rafter
Plan (Aşõk kirişi planõna) başvurun.)

Görüntü özellikleri iletişim kutusuna geri dönerek Grid tuşuna tõklayõn, Not visible�õ seçin ve Modify
tuşuna basõn. Bu işlem detay görüntüsündeki aks çizgilerini siler.

Dikkat: Detay içerisinde herhangi bir değişiklik yapmak için mavi sõnõr çizgisini seçerek aktif hale
getirmelisiniz.
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Diğer tuşlara da dokunarak mevcut ayarlarõ deneyin ve şekli değiştirip geliştirmeye çalõşõn. (Parça,
Cõvata v.s.)

 Detayõn ebadõ ve derinliği Extrema kutusundaki değerler değiştirilerek ayarlanabilir. Bu özel detay için
minimum x ve minimum y mesafelerinin (-) işaretine ve derinliğin ise (+) işaretine gereksinim duyduğuna
dikkat edin ki; bunlar otomatik olarak hesaba katõlõrlar.

Şimdi gusseli kirişlerin makaslarla birleştiği bir yeri zoomlayõn. Create view from view tool�u kullanarak
birleşimin bir detayõnõ çõkarõn. Detay oluşturulduktan sonra daha önce anlattõğõmõz işlemleri kullanarak
detay üzerinde değişiklikler yapõn.

Create cut view ikonuna tõklayõn.
Pick first point on cut plane sorusuna cevap olarak detaydaki IPE200�ün merkez çizgisinin sol tarafõnõ
seçin. Pick second point on cut plane sorusuna cevap olarak da merkez çizgisinin sağ tarafõndan bir
nokta seçin. Detayõn her iki yanõna kutularõ sürükleyin.
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Çizimin sol alt köşesinde yeni bir kesit belirecektir. Kesiti çizim ekranõnda temiz bir bölgeye taşõmak için
shift�i basõlõ tutarken kesitin sõnõrlarõnõ seçin ve sürükleyin. Detayõmõzõn dersin başõndaki örnek gibi
görünmesi için yazõ kutucuklarõyla azõcõk oynamak lazõm. Kesiti de detaylarõ değiştirdiğiniz gibi değiştirin.

Aşõk kirişleri planõ üzerinde bazõ değişiklikler yaptõktan sonra Open drawing list ikonu üzerine tõklayõn,
çizim listesinden aşõk kirişi planõnõ seçin ve Freeze On tuşuna tõklayõn.

Dikkat: Model üzerinde yaptõğõnõz değişiklikleri güncellemeniz gerektiğinde çizim üzerindeki freeze açõk
konumda ise (dondurulmuş ise) yaptõğõnõz değişiklikler, detaylarõ ve çizimi etkilemeyecektir.
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Ankraj  Bulon Planõnõ Hazõrlayõn

Şimdide görünüş özellikleri iletişim kutusundan kesme mesafelerini ayarlamak için Ankraj Cõvatalarõ
planõnõ kullanacağõz.
Çizim listesinden AB1 Anchor Bolt Plan�õ açõn.
Mavi sõnõr çizgisine çift tõklayõn. (Tüm çizimi içine alan çizim çerçevesini değil.)
Görünüş özellikleri iletişim kutusunda çizim üzerindeki nesneler arasõndaki boşluklarõ kõsaltmaya
yarayan kontroller vardõr.

Min dist: kutusu  içindeki değer nesneler arasõndaki mesafeyi kontrol eder ve Xsteel bu değeri kesim
yapma işlemini dikkate alõp almamakta kullanõr.

Length: kutusundaki değer çizim üzerinde kesim yapõlacağõnõ göstermek amacõyla çizim üzerinde
verilen boşluklarõ kontrol eder.

Cut skew parts�õn yanõndaki aşağõ açõlõr kutu ise eğri parçalarõ kõsaltma seçeneğini sunar. (Kesilmiş eğri
parçalar genellikle dirsek gibi görünür.)

Kesme ayarlarõnõ düzenleyin ve Modify düğmesine basõn.
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Makas Çizimini A 1 Çizim Kağõdõna Sõğdõrmaya Çalõşõn

İlk olarak makasõn asamble çizimlerini oluşturalõm.
Makas çizimine ölçüler eklemeden önce ölçeği A 1 çizim kağõdõna sõğacak şekilde ayarlayõn. Xsteel
muhtemelen makasõ önceden tanõmlõ olarak AO kağõdõna (1152*828) sõğacak şekilde yerleştirecektir.

Makas çizimini açõn ve çizim penceresine sağ tuşla tõklayõp Properties�i seçin. Bu çizimin özelliklerine
ulaşmak için iletişim kutusunun alt kõsmõndaki Get tuşuna tõklayõn.

Size definition mode�(ebat tanõm modu) unu Autosize�(otomatik ebatlandõrma) dan Specified size� a
(belşirtilmiş ebat) değiştirin.

Layout (plankote) tuşuna dokunun ve sonra Autoscale on/off (otomatik ölçek)  kontrol kutusundaki
işareti kaldõrõn. Table layout (tablolar planõ) için assembly_A1�i seçin. Main View Scales (temel
görüntü ölçekleri) alanõnda ve Cut Scales  (kesim ölçekleri) alanõnda, ölçekler listesinin sonuna 20 25
30 35 ekleyin ve Modify tuşuna tõklayõn.

Bu ölçekler Xsteel�in asambleyi A1 çizim kağõdõna yerleştirirken deneyeceği farklõ ölçeklerdir.
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Şimdi makas A1 çizim kağõdõna sõğmalõdõr.
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Makas Çizim Ölçülerini Değiştirme

Çizim listesinden makas çizimini açõn.

Gereksiz ölçüleri iptal edin ve makasõ üretmek için gerekli olan ölçüleri ekleyin. GA çizimlerini yaparken
öğrendiğimiz teknikleri kullanarak gerekli kesit görünüşlerini ve büyütülmüş detaylarõ ekleyin.

Çizimi bitirdiğinizden emin olduktan sonra Freeze (dondurun) yapõn ki böylece çizim ileride
güncellendiğinde eklediğiniz bu ölçüler ve detaylar muhafaza edilebilsin. Bunu yapmak için basitçe çizim
listesinden bu çizimi aktif hale getirin ve çizim listesinin sağõndaki Freeze tuşuna basõn. Bu işlem çizim
ortamõnda veya modelleme ortamõnda yapõlabilir.

Dikkat: Bir ölçülendirme çizgisini , parça markasõnõ veya kaynak sembolünü yeniden düzenlemek için
tõklayõp istenen yere sürükleyin.
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Ders 12 � Gözden Geçirme, Kontrol Alõştõrmalarõ

Makasõn uç plakalarõnõ iptal edip eğitim 8 modelini yeniden numaralandõrmak 2

Numaralandõrma Geçmişi Dosyasõ 3

Gözden geçirilen çizimleri güncellemek 5

Detaylandõrõlmamõş eleman olup olmadõğõnõ kontrol etmek  6

Gözden geçirilen çizimlere revizyon numarasõ eklemek 7
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Makaslardan uç plakalarõnõ iptal etmek ve eğitim modeli 8�i yeniden
numaralandõrmak

Gözden geçirmeye örnek olmasõ amacõyla, basitçe makasõn sol ucundaki uç plaka birleşimini iptal edip
bunun model çizimi üzerinde nasõl bir etki yapacağõnõ inceleyeceğiz.

Eğitim modeli 8�in üç boyutlu görünüşünü açõn ve makasõn sol başõnõ zoomlayõn.

Makasõn sol ucundan, üst başlõk üzerindeki uç plakasõ düğüm noktasõ sembolünü aktif hale getirip silin.

Şimdi herhangi bir rapor çalõştõrõp etkilenen çizimleri açmadan önce modeli yeni baştan
numaralandõrmalõyõz.

Setup çekme menüsünden Numbering Setup iletişim kutusu içindeki ayarlarõ kontrol edin. Revize
edilecek elemanlarda �mümkünse numarayõ koru� ayarõnõ yapmakta mümkündür.

Tools çekme menüsünden Numbering-Full�u seçin.

Modeli numaralandõrdõktan sonra etkilenen çizimleri görmek için çizim listesinde üzerine bayrak konmuş
olanlarõ kontrol edin.

Bir �P� bayrağõ çizim üzerinde parçalarõn değiştiğini ifade eder. Diğer bir ifade ile yeni parça mõ
eklenmiş veya iptal mi edilmiş yoksa nesnelerin şekil ve ölçülerimi yenilenmiş gibi sorulara cevap verir.

Bir �N� bayrağõ değişen elemanlarõn miktarõnõ bildir yani şu elemandan revizyon öncesi şu kadar vardõ
şimdi ise şu kadar var gibi.

Şimdi model içinde kaç elemanõn revizyondan etkilendiğini kontrol etmemiz gerekiyor. Çizim listesinden
önünde �P� ve �N� beliren çizimleri seçip seçim listesinde bulunan Select Parts tuşuna basõn. Bu işlem
model içinde revizyondan etkilenen tüm parçalarõ aktif hale getirir. Bu nelerin revize edildiğinin görsel
kontrolüdür.
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Numaralandõrma Geçmişi Dosyasõ

Şimdide bir asamble veya parçanõn yeniden numaralandõrõlõp numaralandõrõlmadõğõnõ anlamak için
numaralandõrma geçmişi dosyasõnõ kontrol etmemiz gerekiyor. Ekranõn üst kõsmõndaki menüden Tools-
>Display log file->Numbering history log...zincirini tõklayõn. �Numaralandõrma geçmişi� dosyasõ
modelin bulunduğu dizinde yer aldõğõ için Windows Explorer kullanõlarak da açõlabilir.

Örnek bir numaralandõrma geçmişi raporu aşağõdaki gibi olacaktõr:
*** Numbering: ******************************
Wed Aug 19 15:46:39 1998

Tüm numaralandırmalar
Yeni parçaları eskileri ile kar şıla ştır
Duru ş şekli
Tolerans: 1.000000

XXXP-/1 Max Part 0 Max Assembly 0 FreeNo 0
XXXA-/1 Max Part 0 Max Assembly 0 FreeNo 0
XXXE-/1 Max Part 0 Max Assembly 0 FreeNo 0

Xp/1 Max Part 76 Max Assembly 0 FreeNo 0
Xm/1 Max Part 2 Max Assembly 0 FreeNo 0

XXXB-/1 Max Part 0 Max Assembly 0 FreeNo 0
XXXC-/1 Max Part 0 Max Assembly 0 FreeNo 0

m/1 Max Part 85 Max Assembly 0 FreeNo 0
B/1 Max Part 0 Max Assembly 27 FreeNo 0

BR/1 Max Part 0 Max Assembly 8 FreeNo 0
C/1 Max Part 0 Max Assembly 12 FreeNo 0
P/1 Max Part 0 Max Assembly 24 FreeNo 0
R/1 Max Part 0 Max Assembly 6 FreeNo 0
T/1 Max Part 0 Max Assembly 1 FreeNo 0

XXXP-/1 Max Part 0 Max Assembly 0 FreeNo 0
XXXA-/1 Max Part 0 Max Assembly 0 FreeNo 0
XXXE-/1 Max Part 0 Max Assembly 0 FreeNo 0

Xp/1 Max Part 76 Max Assembly 0 FreeNo 0
Xm/1 Max Part 2 Max Assembly 0 FreeNo 0

XXXB-/1 Max Part 0 Max Assembly 0 FreeNo 0
XXXC-/1 Max Part 0 Max Assembly 0 FreeNo 0

m/1 Max Part 85 Max Assembly 0 FreeNo 0
B/1 Max Part 0 Max Assembly 27 FreeNo 0

BR/1 Max Part 0 Max Assembly 8 FreeNo 0
C/1 Max Part 0 Max Assembly 12 FreeNo 0
P/1 Max Part 0 Max Assembly 24 FreeNo 0
R/1 Max Part 0 Max Assembly 6 FreeNo 0
T/1 Max Part 0 Max Assembly 1 FreeNo 0

*** Numbering finished ******************************

Bu numaralandõrma geçmişi raporuna göre parçalardan veya asamblelerden hiçbiri tekrardan
numaralandõrõlmamõş. Bunu da raporun solunda oklarõn gösterildiği yerde Part veya Assembly
kelimelerinin listelenmemiş olmasõndan anlõyoruz.
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Eğer parçalar veya Asambleler herhangi bir sebepten dolayõ yeniden numaralandõrõlmõşlarsa
numaralandõrma geçmişi dosyasõ aşağõdaki gibi görülebilir:

*** Numbering: ******************************
Wed Aug 19 15:46:39 1998

Tüm numaralandırmalar
Yeni parçaları eskileri ile kar şıla ştır
Duru ş şekli
Tolerans: 1.000000

XXXP-/1 Max Part 0 Max Assembly 0 FreeNo 0
XXXA-/1 Max Part 0 Max Assembly 0 FreeNo 0
XXXE-/1 Max Part 0 Max Assembly 0 FreeNo 0

Xp/1 Max Part 76 Max Assembly 0 FreeNo 0
Xm/1 Max Part 2 Max Assembly 0 FreeNo 0

XXXB-/1 Max Part 0 Max Assembly 0 FreeNo 0
XXXC-/1 Max Part 0 Max Assembly 0 FreeNo 0

m/1 Max Part 85 Max Assembly 0 FreeNo 0
B/1 Max Part 0 Max Assembly 27 FreeNo 0

BR/1 Max Part 0 Max Assembly 8 FreeNo 0
C/1 Max Part 0 Max Assembly 12 FreeNo 0
P/1 Max Part 0 Max Assembly 24 FreeNo 0
R/1 Max Part 0 Max Assembly 6 FreeNo 0
T/1 Max Part 0 Max Assembly 1 FreeNo 0

Part 68033 series:p/1 p/62 -> p/64
Part 71712 series:p/1 p/62 -> p/64
Part 71716 series:p/1 p/62 -> p/64

XXXP-/1 Max Part 0 Max Assembly 0 FreeNo 0
XXXA-/1 Max Part 0 Max Assembly 0 FreeNo 0
XXXE-/1 Max Part 0 Max Assembly 0 FreeNo 0

Xp/1 Max Part 76 Max Assembly 0 FreeNo 0
Xm/1 Max Part 2 Max Assembly 0 FreeNo 0

XXXB-/1 Max Part 0 Max Assembly 0 FreeNo 0
XXXC-/1 Max Part 0 Max Assembly 0 FreeNo 0

m/1 Max Part 85 Max Assembly 0 FreeNo 0
B/1 Max Part 0 Max Assembly 27 FreeNo 0

BR/1 Max Part 0 Max Assembly 8 FreeNo 0
C/1 Max Part 0 Max Assembly 12 FreeNo 0
P/1 Max Part 0 Max Assembly 24 FreeNo 0
R/1 Max Part 0 Max Assembly 6 FreeNo 0
T/1 Max Part 0 Max Assembly 1 FreeNo 0

Assembly 36860 series:R/1 R/3 -> R/5
Assembly 41321 series:R/1 R/5 -> R/6
*** Numbering finished ******************************

Değişen satõrlar koyu harflerle gösterilmiştir. Üstteki rapor üç tane p/62 parçasõnõn yeniden p/64 olarak
numaralandõrõldõğõnõ anlatmaktadõr. Buna ek olarak; R/3 Asamblesi R/5 ve R/5 asamblesi ise  R/6 olarak
değiştirilmiştir.

Umduğunuz veya istediğiniz sonucu alamadõysanõz son numaralama işlemini Undo komutu ile geri alõp farklõ bir
numaralandõrma seçeneğini deneyebilir veya parçalarõn neden bu şekilde numaralandõğõnõ kontrol edebilirsiniz.
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Yenilenen  çizimin güncellenmesi

Eğer yapõlan değişikliklerden memnunsanõz değişikliğe uğrayan çizimi güncellemeniz gerekmektedir.
Değişikliğe uğrayan çizimi çizim listesinden seçerek aktif hale getirin ve seçim listesinin en altõndaki
Update�i tõklayõn.

Tavsiye: Hangi çizimlerin güncellendiğini bir yere not edin. Bu, ileride bu çizimleri kullanmanõz
gerektiğinde yardõmcõ olacaktõr.

Bu işlem �P� bayraklõ dondurulmamõş çizimlerin tümünü yeni baştan çizecek, çizim üzerindeki �N�
bayraklõ �miktarlarõ� güncelleyecek ve dondurulmuş çizimlerin üzerindeki �P� bayrağõnõ da �*��a
dönüştürecektir. Bu işaret, elemanõn şeklinin yeni düzenlemeye bağlõ olarak değiştirildiğini fakat
dondurulmuş olduğu için parça markalarõnõn ve ölçülerin henüz değiştirilmediğini gösterir.

Uyarõ: Eğer kullanõcõ ölçülendirme işini elle yapõp tamamlamayacaksa dondurulmuş çizimlerin
güncellenmesi eksik veya yanlõş ölçülendirmeye yol açabilir.

Bu yüzden güncelleme işlemi için dondurulmuş çizimi açõp Edit çekme menüsünden Update Marks- All
Parts�õ seçip markalarõ güncellemeniz gerekmektedir.

Sonrada güncellenmesi gereken ölçülerin tümünü ayarlamanõz gerekmektedir.

İşlemden sonra dondurulmuş çizimden çõkõp bunu kaydettiğiniz de �*� işareti kaldõrõlõr.
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Detaylandõrõlmamõş eleman olup olmadõğõnõ kontrol etmek

Son olarak revizyon sonrasõ yeniden çizilmesi gereken elemanlar olup olmadõğõnõ kontrol etmemiz
gerekiyor. Bu daha önce iki tane  iken bir taneye düşmüş elemanlar için söz konusu olabilir. Bu
elemanlardan biri müteakiben çizilebilir.

Properties çekme menüsünden Assembly drawing�i seçin.

Name yazõ alanõna NOT DRAWN yazõn ve iletişim kutusundan Apply tuşuna basõn.

Şimdi tüm modeli çerçeve içine alõp Drawing çekme menüsünden Assembly drawing�i seçin.

Artõk Xsteel detaylandõrõlmamõş tüm asambleleri detaylandõracaktõr.

Dikkat: Xsteel bir şeyi iki kez detaylandõrmaz.

Şimdi bu işlemleri tekil parça çizimleri için tekrarlayõnõz.
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Gözden geçirilen çizime revizyon numarasõ ekleyin

Çizimleri güncellemeden önce hangilerinin gözden geçirildiğini not almõş olmanõz gerekir.

Çizim listesinden bu çizimleri aktif hale getirin ve çizim listesinin sağõndaki Revizyon tuşuna basõn.
İletişim kutusunu aşağõdaki gibi tamamlayõp Create once tuşuna basõn.

Bu işlem listede aktif haldeki çizimlere revizyon ekleyecektir.

Şimdide işleme koymak üzere yazdõrõlabilirler.

İpucu: Seçim listesindeki revizyon numarasõ veya revizyon markasõndan istediğiniz birini seçip
görüntüleyebilirsiniz. Eğer revizyon markasõnõ görüntülemek istiyorsanõz grup dosyanõz içindeki ortam
ayarlarõnõzõ      XS_SHOW_REVISION_MARK_ON_DRAWING_LIST=TRUE�ya ayarlayõnõz.
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Ders  13 � Kullanõşlõ Çizim Araçlarõ

Ders 13�te daha önce değinmediğimiz bazõ çizim araçlarõnõn kullanõmõnõ gündeme getireceğiz.

Ölçü Çizgilerini Birleştirmek

Ölçü Noktasõ Eklemek veya Kaldõrmak

Kot Markasõ

Kaynak İşareti

Ölçülendirme Şeçenekleri

  Kaydet, Farklõ Kaydet, Yükle

  Doğrudan

  Açõ Tipi

  Hassasiyet

  Biçim

  Yazõ Rengi

Dikine Çizgiler

Çok Satõrlõ Yazõ

Semboller Girmek

Parça Markalarõ Oluşturmak
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Çizim Görünüşlerini Kopyalamak ve Birleştirmek

   Çizim Görünüşlerinin Kopyalanmasõ

   Çizim Görünüşlerinin Birleştirilmesi

   Çizim Görünüşlerinin Plan Üzerine Kopyalanmasõ

   Çizim Görünüşlerinin Plan Üzerine Birleştirilmesi

Görüntüyü Döndür

Markalarõn Güncellenmesi

Filtre Seç

Çizim Listesi Komutlarõ

  Aç

  Güncelle

  Markalarõ Güncelle

  İptal Et

  Görüntüle

  Filtrele

  Kilitle

  Kullanõma Aç

  Gözden Geçir
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Ölçü Çizgilerini Birleştir

Birbirine paralel iki veya daha fazla ölçüyü veya ölçü grubunu tek çizgide birleştirmek istediğinize
kullanõrsõnõz.

Ctrl tuşunu basõlõ tutarak birleştirmek istediğiniz ölçüleri seçin. İkona basõn (veya fare sağ tuşuna) ve
Combine dim lines�i seçin.

Ölçü Noktasõ Eklemek / Kaldõrmak

Mevcut ölçüyü oluşturan noktalarõn yerini değiştirmek istediğinizde kullanõrsõnõz. Değiştirmek istediğiniz
ölçüyü seçin; bir defada sadece bir ölçü değiştirebilir. Uygun kutusunu seçin (veya fare sağ tuşuna
tõklayõp ya Ad dimension point veya Remove dimension point�i seçin) değiştirmek istediğiniz noktayõ
ekleyin veya kaldõrõn.   
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Kot İşareti

Bu komut çizim içerisinde seçtiğiniz bir noktaya kot markasõ koyar.

Ekranõn sol tarafõndaki çizim menü çubuğu üzerindeki Level mark ikonuna çift tõklayõn.
Bu işlem Kot markasõ atamalarõ iletişim kutusunu açar. Buradan kot markasõnõn çizim içinde nasõl
görünmesini istediğinize dair değişiklikler yapabilirsiniz.

İstediğiniz değişkenleri ayarlayõp OK tuşuna basõn.
Çizim üzerinden kot markasõnõ tanõmlamak istediğiniz noktayõ
seçin ve markanõn görünmesini istediğiniz noktaya tõklayõn.
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 Kaynak Sembolü

Kaynak sembolü aracõ, çiziminiz üzerine görmek istediğiniz kaynak sembollerini ekler.

İletişim kutusunu açmak için Create weld symbol  ikonuna çift tõklayõn.

İstediğiniz kaynak tipini belirlemek için Type aşağõ
açõlõr menüsünü açõn. Sembol için ihtiyaç
duyacağõnõz diğer gerekli bilgileri girin.
Reference text kutusu istediğiniz notu kaynağõn
ucuna (kuyruğuna) eklemenizi sağlar. İşiniz bitince
OK� e basõn.

Çizim üzerinde kaynağõn uygulanmasõnõ
istediğiniz noktayõ ve sembolün yerleştirilmesini
istediğiniz noktayõ seçin. Create weld symbol
aynõ zamanda mevcut bir kaynak sembolünün
değiştirilmesinde de kullanõlabilir.
(Fakat modelde görülen kaynaklarõn değil.)
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Ölçü Seçenekleri

Dimension komutu seçilen iki nokta arasõna ölçü koyar. Snap anahtarlarõ hangi noktalarõn seçileceğini
kontrol etmekte kullanõlõr.

Ölçü özellikleri Dimension Properties iletişim
kutusundan ayarlanõr. İletişim kutusunu açmak
için ölçü kutularõndan birinin üstüne çift tõklayõn.

Kaydet, Farklõ Kaydet, Yükle
Farklõ seçeneklerde sunulan değerleri
ihtiyaçlarõnõza göre ayarladõktan sonra bu
ayarlarõ standard olarak Save (Kayõt) edin.

Özel bir proje için standart ayarlar üzerinde
değişiklik yapma ihtiyacõ isteyebilirsiniz. Önceden
tanõmlõ değerleri değiştirmek için üzerlerinde
değişiklikler yapõp Save as komutunu kullanarak
bu değişiklikleri özel bir ad altõnda kaydedin.
Aşağõ açõlõr menüden kaydedilmiş önceden
tanõmlõ değerleri seçip Load dediğinizde değerler
önceden tanõmlõ değerlere geri döner.
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Doğrudan

Aşağõ açõlõr menüden bir ölçü stili seçin.

Dikkat: Ara ölçüler her zaman mutlak ölçülerdir.

Relatif Mutlak

Relatif ve mutlak
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Açõ Türü :

Angle type görüntülenecek açõ ölçüm tipini tanõmlar

Hassasiyet:

Precision görüntülenen ölçü üzerindeki sayõnõn yuvarlama faktörünü kontrol eder.

Format:

Format ölçü numarasõnõn hangi biçimde görüntüleneceğini belirler. Parantez içinde gösterilen sayõsal
seçime bağlõdõr ve sadece gerektiğinde gösterilir. Örneğin; biçim ###.[#] şeklinde seçildi ise 100.0 sayõsõ
100 olarak yazõlõr ve eğer biçim ###.# şeklinde seçildi ise bu sayõ 100.0 olarak yazõlõr.
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Metin  Rengi:

Bu renkler çizim içindeki çizgi kalõnlõklarõnõ kontrol eder.

Çizgi kalõnlõklarõ ile ilgili daha fazla bilgi almak için Contents->Modeling->File->Database->Plotters-
>Modify...(On NT) altõndaki Coloor table ve Pen number ile ilgili yardõm dosyalarõnõ okuyun.
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Dikey Çizgiler

Ortho komutu çizgi komutuyla beraber kullanõldõğõnda seçilen bir başlangõç noktasõndan itibaren 45
derecelik basamaklarla doğrusal çizgiler çizmeye yarar.

Ortho�yu aktif hale getirmek için çizgi komutuyla başlayõp ister yakalama ayarlarõ araç çubuğunu
kullanarak ister klavye üzerindeki O tuşuna basarak bir başlangõç noktasõ seçin.

Dikkat: Yakalama ayarlarõ araç çubuklarõnõn kullanõmõ ile ilgili daha fazla bilgi edinmek için Drawings-
>Setup->Entering/locking coordinates zinciri altõnda bulunan yardõm dosyalarõndaki alõştõrmalarõ
okuyun ve uygulayõn.
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Çok Satõrlõ Yazõ

Menüden Pick Create->Text->Text [multi] zincirini izleyip yazõ için bir başlangõç noktasõ seçin. Yazõ
satõrõnõ yazõn ve sonra ya create�õ tõklayõn veya yeni bir yazõ satõrõna başlamak için enter tuşuna basõn.
Her satõr soldan başlayarak ve bir önceki satõrla aynõ çizgiden başlayarak yazõlõr.
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Sembolleri Girmek

Symbol kutusuna  çift tõklayõn.
Select tuşuna basõn ve önceden tanõmlõ sembollerden seçin.
Apply tuşuna veya OK tuşuna basõn.
Symbol kutusuna bir kez tõklayõn ve sembolün yerini belirlemek için çizim üzerinde bir yere tõklayõn.
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Kõsmi Parça Markalarõ

Parça markalarõ �Part mark properties� (parça marka özellikleri) iletişim kutusundan ayarlanõr.

Herhangi bir asamble çizimini açõn.
Geri plandaki çizime sağ tuşla tõklayõn.
Asamble çizim özellikleri iletişim kutusundan Part mark... tuşuna tõklayõn.

Part mark properties (Parça marka özellikleri) iletişim kutusundan hangi parçalarõn markalanmasõ
gerektiğini ve markalarõn nasõl görüneceğini ayarlayabilirsiniz.
Mevcut bir marka da part mark iletişim kutusundan değiştirilebilir.

Değişikliklerinizi yapõp Modify tuşuna tõklayõn.

Dikkat: Markalanmamõş bir parçayõ markalamak için parçayõ seçip sağ tuşla tõklayõn ve Part mark�õ
seçin.
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Çizim Görünüşlerinin Kopyalanmasõ ve Birleştirme

Bu ve buna ilişkin komutlar (plana bağlõ görünüş çizimi kopyalama, plana bağlõ görünüş çizimi
birleştirme) bir çizimden bir başka çizime görünüşler eklemenize olanak sağlar.

Çizim listesini açõn.(Drawing list kutusuna tõklayõn.)
Listedeki çizimlerden birini rasgele açõn.
Çizim listesinden bir başka çizimi aktif hale getirin.
Ekranõn üst kõsmõndaki çizim menüsü üzerinden Create->Copy drawing views zincirini seçin.
Kopyalanan çizimden alõnan görünüşler açõk çizim üzerinde belirir.

Copy ve linking komutlarõ arasõnda çok az farklõlõk vardõr.

   Çizim Görünüşlerinin Kopyalanmasõ:

•  Görünüşleri bir plan kullanmadan kopyalar. (başlõk bloğu, malzeme listesi v.b.)
•  Kopyalanan görünüşler model içinde yapõlan değişikliklerden etkilenmez, güncellenmez.

   Çizim Görünüşlerinin Birleştirilmesi:

•  Kopyalama (Copy) komutuna benzer şekilde �Link drawing views� (Çizim görünüşlerini birleştir)
komutu çizimleri bir plana bağlõ olmadan birleştirir.

•  Görünüşler model içinde yapõlan değişikliklerden etkilenerek güncellenir.

Plana Bağlõ Çizim Görünüşlerinin Kopyalanmasõ:

•  Adõndan da anlaşõlacağõ gibi planlar görünüşlerle birlikte gelir.
•  Model içindeki değişikliklerden etkilenir, güncellenir.

Plan Bağlõ Çizim Görünüşlerinin Birleştirilmesi:

•  Bu işlem aynõ zamanda plana bağlõ görünüşler ekler.
•  Model üzerinde yapõlan değişikliklerden etkilenir.

Dikkat: Bir Plana bağlõ olarak eklenmiş çizim görünüşlerine sahip çizimler, planõn görülebilir olmasõ için
önce kapanmalõ sonra tekrar açõlmalõdõr.



                                                                                                                      

Xsteel Eğitim Kursu                                                                                                           Ders 13  � Kullanõşlõ Çizim Araçlarõ

Copyright Tekla Oyj 2000,  Computers & Engineering 2002  Tel: 0049 6406 73667   www.comp-engineering.com           Sayfa 13-15

CCCOOOMMMPPPUUUTTTEEERRRSSS   &&&
EEENNNGGGIIINNNEEEEEERRRIIINNNGGG

Görünüşü Döndür

Görünüşü döndürmek için herhangi bir çizimi açõn.
Aktif hale getirmek için mavi sõnõr çizgisine tõklayõn.
Sağ tuşla tõklayõp Rotate�i seçin.(Veya menüden Edit->Rotate View�i seçin.)
Bu işlem Rotate view iletişim kutusunu açar

Angle için bir değer girin ve Rotate tuşuna basõn.
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Markalarõn Güncellenmesi

Bir model üzerinde değişiklikler yapõldõğõnda çizimlerin tekrar açõlmadan önce güncellenmesi
gerekmektedir. Eğer çizim üzerinde Freeze özelliği açõk değilse güncelleme yapõldõğõnda markalar ve
ölçüler otomatik olarak güncellenir. Eğer Freeze (Dondurmak) özelliği açõk ise çizimi güncellemek
istediğinizde onu açõp markalarõ güncellemeniz ve ölçüleri de elle oluşturmanõz gerekmektedir.

Bir çizimi açõn.
Edit->Update marks�õ seçtiğiniz zaman istediğiniz herhangi bir markayõ veya isterseniz tümünü birden
değiştirme şansõnõz vardõr.

Tüm markalarõ sağ tuşla tõklayõp Update marks�õ seçerek güncelleyebilirsiniz.

Filtre Seç

Setup->Select filter  zinciri ekran üzerinden seçilebilecek nesneleri tanõmlar. (Modelleme ortamõndan
veya çizim ortamõndan)
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Notlar:
1. Filtre zinciri ile ilgili bilgiler model içindeymiş gibi tamamen görünmelidir.(Büyük harflerle ifade

etmek, küçük harflerle ifade etmek, tam isimler v.s.)
2. bir nesnenin seçilebilmesi için model içinde görülebilir olmasõ gerekir
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Seçim Anahtarlarõ

Seçim anahtarlarõna ekranõn sol üst kõsmõndan ulaşõlabilir.

Herhangi bir nedenden dolayõ çizim içinde belirli bir nesneyi seçmek isteyebilirsiniz, bunun için buna
karşõlõk gelen anahtarõ seçebilirsiniz. Bu işlemden sonra sadece bu tip nesneler seçilebilir olur. Normal
ayarlamalar ise Any object tuşuna basõlarak yapõlabilir.
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Çizim Listesi Komutlarõ

Aşağõda, çizim listesindeki komutlarõn her birinin kõsa bir açõklamasõnõ bulacaksõnõz.

Açõk

Çizim listesinden herhangi bir çizimi seçip aktif hale getirin sonrada Open tuşuna basõn.

Aynõ işlemi çizim listesindeki bir çizimin üzerine çift tõklayarak da yapabilirsiniz.

Güncelle

Üzerinde �P� veya �N� bayraklarõndan birini taşõyan herhangi bir çizimi seçin ve sonra model içindeki
herhangi bir değişiklikten dolayõ gereken güncellemeyi yapmak için Update tuşuna basõn.

Markalarõ Güncelle

Listeden seçilen çizimlerin herhangi birindeki markalar tuş aracõlõğõ ile güncellenebilir.

İptal

Seçim listesinden dondurulmuş veya kilitlenmişler de dahil istediğiniz tüm çizimleri siler, kaldõrõr.
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Görüntüle (Display)

Tümünü (All)

Listelenen tüm çizimleri görüntüler.

Tersini (Invert)

Filtre edilen grubun dõşõndakileri görüntüler.

Filtreler

Seçilenler  (Selected)

Seçilen bir çizimi veya çizim gurubunu filtreleyip onlarõ çizim listesinde görülebilen yegane çizimlere
çevirir.

Güncellenmişler (Up to date)

Bu, sadece güncellenmiş çizimleri çizim listesinde görülebilir hale getirir.

Seçili Kõsõmlar (Select Parts)

Çizimleri listeden seçtikten sonra Select Parts tuşuna basarsanõz model içinde seçilenlere karşõlõk gelen
parçalar parlar.

Kõsmi (By Parts)

Model içinde nesneleri seçip By Parts tuşuna basarsanõz, seçim listesi sadece seçtiğiniz parçalar
görülecek şekilde filtrelenir.
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Kilit (Lock)

Aktif (On)

Çizimleri kilitlemenin amacõ üzerinde değişiklikler yapõlmasõnõ engellemektir. Güncelleme bayraklarõ hala
mevcut olabilir.

Kapalõ (Off)

Kilitleri kaldõrõr ve çizimler üzerinde değişiklikler yapõlabilir.

Hayata Geçirmek  (Issue)

Açõk (On)

Bu komut hayata geçirilecek çizimlerin yanõndaki bayraklar kolonuna �I� harfi koyar.

Kapalõ (Off)

Bu işlem ise çizim listesinde yanõndaki bayraklar kolonunda �I� bulunan çizimlerin I işaretlerini kaldõrõr.
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 Revizyon... (Gözden Geçirme)

Gözden geçirme işlemine ait bilgilerin eklenmesi, değiştirilmesi veya kaldõrõlmasõ işlerinin halledildiği
iletişim kutusunu açar.

Markalama

Çizimleri markalarken revizyon numaralarõnõn girilmesinde kullanõlõr.

Revizyon aşağõ açõlõr kutusu

Revizyon markasõnõn yanõndaki kutu yapõlan revizyonlarõn numaralarõnõ taşõr ve otomatik olarak
güncellenir. Her çizim kendi bağõmsõz revizyon numarasõna sahiptir.

Tarih

Revizyon tarihi otomatik değildir yazõlabilen bir yazõ alanõndan oluşur.
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Yazõ

Yapõlan revizyonlarõ ifade etmek amacõ ile üç satõrdan oluşan bir metin kullanõlabilir.

İptal

İptal tuşu aşağõ açõlõr revizyon kutusunda listelenen revizyonlar arasõndan seçilen revizyonu kaldõrõr.
Revizyon numarasõnõn iptal edilmesinden sonra aşağõ açõlõr revizyon kutusunda kalan numaralar
yeniden numaralandõrõlõr.(Revizyon markalarõ değişmez.)
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Ders  14  � Çizim  Planõ

Çizim planõ ne demektir ?

Bir asamble çizimini malzeme listesi olmadan oluşturmak
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Çizim planõ ne demektir?

Asamble, Tekil Parça, Genel Düzenlemeler ve Çoklu Parça Çizimleri gibi her çizimin bir plan dosyasõ
vardõr ve bu dosyalar mevcut kağõt ölçülerine göre belirlenmiş özel çizim tipleri ve yine bu kağõtlar
üzerinde gösterilecek şablon yerlerine dair bilgiler içerir.

Bu planlar aracõlõğõyla çizimlerin yerleştirileceği yerler ayarlanõr. Mesela; A1 ve A3 ölçüsündeki çizim sayfalarõna Asamble
çizimleri A3 ve A4 ölçüsündeki çizim sayfalarõna ise tekil parça çizimlerinin yerleştirileceği gibi.

Başka bir örnek olarak bu yer Asamble çiziminin bir malzeme listesi içereceğinin fakat General Arrangement çiziminin
içermeyeceğinin belirlendiği yerdir.
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Bir asamble çizimi için malzeme listesi olmayan bir plan  oluşturmak

Çekme Properties  menüsünden Layout �u seçin.

Sol taraftaki mevcut plan (layout)  listelerinden assembly�i  seçin. Şimdi de yeni bir deneme planõ için bir isim yazõn: Train_A3
(Aşağõdaki iletişim kutusunu inceleyin.) ve Add  tuşuna basõn. Bu şekilde asamble planõna sahip belli bir plan tanõmlamõş
oldunuz.
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İletişim kutusunun sağõndaki seçeneklerden Table Layout� u seçin.

Sol taraftaki mevcut tablo planlarõndan assembly_a3  seçeneğini seçin ve sonrada iletişim kutusunun
altõndaki Tables  tuşuna basõn.

Şimdide ekranda Tables iletişim kutusunu görüyorsunuz; burada sol tarafta mevcut çizim tablolarõnõn
(şablonlarõnõn) bir listesini ekranõn sağõnda da seçili çizim tablolarõnõn (şablonlarõnõn) bir listesini
bulacaksõnõz.

Şimdi de Chosen Tables penceresinde görülen aks  şablonunu kaldõrmak istiyoruz.
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Aks çizgilerini kaldõrmak için ilk olarak Chosen Tables penceresinden bunu aktif hale getirin. Bu
şablonun özellikleri (konum, ölçek v.s.) aşağõ kõsõmda gösterilmiş olmalõdõr.

Chosen Tables penceresinde bulunan şablonlarõn yerlerine dikkat ettiyseniz; bazõlarõnõn çizim
çerçevesine bazõlarõnõn da diğer şablonlara ekleneceğini görürsünüz. Chosen Tables penceresinden
mevcut bir grid   şablonunu kaldõrmak istediğimizde işlemi yapmadan önce buna bağlanmõş herhangi
başka bir şablonun olmadõğõndan emin olmalõyõz. Aksi takdirde bu hata sonucunda çizim sayfasõnda hiç
şablon yokmuş gibi görünür. (Genel bir hatadõr.)

Buradaki durumda Aks tablosuna herhangi başka bir tablo bağlantõlõ değil.

Liste tablolarõ arasõndaki oklardan alttakini seçerseniz Chosen Tables penceresinden aks tablolarõnõ
kaldõrmõş olursunuz.
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Şimdi Tables iletişim kutusundan Chosen tables alanõ altõndaki Update  tuşuna basõn ve sonrada
OK�leyin. Daha sonra Table Layout (tablo planlarõ) iletişim kutusundan önce Update�e sonrada OK�e
basõn. Son olarak da Layout iletişim kutusundan OK�e basõn.

Şimdide çizim listesinden mevcut bir A3 çizimini seçin ve Properties  çekme menüsünden  Assembly
drawing...�i seçin. Layout tuşuna tõklayarak Assembly Layout iletişim kutusunu görülebilir yapõn. Layout
�yi assembly� den Train_A3� e değiştirin ve modify  tuşuna basõn. Şimdide sonuçlarõ kontrol etmek için
seçilmiş olan A3 çizimini açõn.

Çizim içinde layout�u değiştirdiyseniz değişikliği görebilmek için çizimi save edip kapamanõz sonrada
tekrar açmanõz gerekir.



                                                                                                                      

Xsteel Eğitim Kursu                                                                                                       Ders 15  �  Sistem Kişisel Ayarlarõ

Copyright Tekla Oyj 2000,  Computers & Engineering 2002  Tel: 0049 6406 73667   www.comp-engineering.com          Sayfa 15-1

CCCOOOMMMPPPUUUTTTEEERRRSSS   &&&
EEENNNGGGIIINNNEEEEEERRRIIINNNGGG

Ders 15- Sistem Kişisel Ayarlarõ

Parola dosyasõ

Yazõcõ Veritabanõ

Standart Dosyalar-Mevcut Ayarlarõ Muhafaza Et

Mevcut Ayarlarõ Muhafaza Et komutu
Diğer standart dosyalar

Dizili  dosyalar (Batch Files) & ve İkon ayarlarõ

İkon ayarlarõ

Dizili  dosyalar  (Batch Files)

Profil, Malzeme & Cõvata Veri Tabanlarõ

Otomatik kayõt � Zaman aralõğõ ayralarõ & Dosya yenileme

Zaman Aralõğõ Ayarõ

Otomatik kayõt dosyalarõnõn yenilenmesi

Kişisel dosyalar � depolama ve sistem yerleştirilmesi

Xsteel depolama dizini dosya yapõsõ
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Parola dosyasõ

Xsteel programõnõzõn kilidi  �bin� dizininde bulunan (C:\Xsteel\6.0\nt\bin) Xsteel parola dosyasõna
doğrudan bağlõdõr.

Yazõ dosyasõ Notepad veya Word pad gibi herhangi bir text editörü (metin yöneticisi) kullanõlarak
yazõlabilir.

Bunun yanõnda, program kilidinin çalõşõr hale gelebilmesi için kurulum CD�sindeki �sentinel� sürücüsünü
kurmayõ da ihmal etmeyin.
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Yazõcõ Veritabanõ

Xsteel standart kurulumu Xsteel yazõcõlar veriabanõnda yazõcõ şekillerine dair örnekler içerir. Yazõcõ
veritabanõna girmek için modelleme ortamõndan File çekme menüsüne gidip Database-Plotters �õ
seçmeniz yeterli olacaktõr. İzleyen örneğimiz �ağ bağlantõlõ tipik yazõcõ şekilleri�ni göstermektedir.

Printer aliases (yazõcõ takma isimleri)  yazõcõ için bağõmsõz takma isimler atar.

Yazõcõ  bu alan; yazõcõnõn yerel mi yoksa ağ bağlantõlõmõ olduğunu gösterir mesela �Server ID\Share
Name�. Eğer yazõcõ yerel bir yazõcõ ise bu alana sadece windows�un kontrol panelindeki yazõcõ ismini
yazmanõz yeterlidir.

Sayfa Ebadõ  �Geniş Biçimli� yazõcõlarda (A1,A0 v.s.) bu değer �By PlotArea�a  ayarlanõr, fakat A3,A4
ebadõna uygun yazõcõlarda doğru ebadõ sizin seçmeniz gerekir.

Çizim Alanõ h*b en büyük yazdõrma alanõ

Renk siyah \ Beyaz Black\White veya renkli Color.
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Çizim Kalemi Haritasõ             Bu bölümde her renk için hangi kalem numarasõnõn
                                                        kullanõlacağõnõ ayarlar. Her bir kalem numarasõnõn kalõnlõğõ
                                                        yazõcõnõn sürücüsüne bağlõdõr, fakat en incesi 1�dir. En kalõnõ
                                                        da 5�dir.

                                                       Dikkat: Aynõ zamanda ortam değişkeni
                                                       XS_BASE_LINE_WIDTH= 0.1 kalem kalõnlõğõnõ kontrol eder.
                                                       Kalem haritasõ değerleri bu değişken içinde verilen sabitlerle
                                                       çarpõlõr.
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Standard Dosyalar � Mevcut Ayarlarõ Koru

Yeni bir projeye başlarken veya Xsteel�i yapacağõnõz özel bir çalõşmaya ayarlayacağõnõz zaman,üzerinde
çalõşõlan tüm modellerde aynõ standart dosyalarõn kalmasõnõ istiyorsanõz Xsteel �system�  dosyalarõna
yerleştirilecek �standart� dosyalar grubunu kendiniz oluşturabilirsiniz.

Eğer dikkat ettiyseniz �save� seçeneği bulunan iletişim kutularõnõn çoğunda ( Kiriş Özellikleri, Makrolar
v.b.) �Load� penceresinin yanõnda bir �standart� ayarõ bulunur.

Bu �standart� dosya Xsteel�in komut aldõğõnda okuduğu ve uyguladõğõ standart bir dosyadõr.

Mevcutlarõ Koru Komutu

Modelleme ortamõnda Setup çekme menüsünden ulaşõlan Save Defaults komutu modelleme ortamõ
kullanõcõ ara yüzü standart dosyalarõndan yaklaşõk 16 dosyalõk bir grubu kaydedebilir.(Kiriş Özellikleri,
Kolon Özellikleri, Kurulum Tercihleri, Proje Özellikleri v.s.)

Kullanõcõ bu iletişim kutularõnõn her birini kontrol etmeli ve içeriği şartlara uyanlardan birini çekme Setup
menüsünden Save Defaults�u seçerek kaydetmelidir. Bu işlem aşağõya listelenen standart dosyalarõ
kullanõlan model dizinine yerleştirir. Eğer bu dosyalar tüm modelleme boyunca kullanõlacaksa Xsteel�in
�System� dizinine kopyalanabilirler. Örneğin; C:\Xsteel\6.0\countries\euro\system  şeklinde.

Standart dosya isimleri ve iletişim kutularõna ait liste aşağõdaki gibidir:

standart.  asv                Otomatik Kayõt
standart.  bcc                Cõvata Çakõşma Kontrolü
standart.  clm                Kolon Özellikleri
standart.  cpl                 Kontür Plakalar
standart.  crs                 Kiriş/ Dikey Yön Kiriş Özellikleri
standart.  dia                 İkiz Profil Özellikleri
standart.  fms                Çizim Çerçevesi
standart.  fpl                 Bükülü Plaka
standart.  ler                 Tabaka Özellikleri
standart.  mvi               Model Görünüş Özellikleri
standart.  num              Kurulum- Numaralandõrma
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standart.  prf                Proje Özellikleri
standart.  Prt                Kiriş Özellikleri
standart.   scr              Cõvata Özellikleri
standart.   stp              Ayarlar- Tercihler
standart.   wld             Kaynak Özellikleri

Diğer Standard Dosyalar

Diğer standart dosyalar modelleme ortamõnda kaydedilmiş makrolarõ ve çizim editörü standart
dosyalarõnõ içerebilir. Örneğin; yazõ ölçüleri, ölçülendirme renkleri, bayrak sembolleri v.s.

Yukarõdaki �standart� dosyalarõndan herhangi birini değiştirmek istediğinizde basitçe  dosya özelliklerini
istediğiniz gibi ayarlayõp bu dosyayõ �standart� adõ altõnda kaydedin. (Bunun küçük harfle ifade
edildiğinden emin olun.)

Bu standart dosyalar en güncel model dizinine yerleştirilir. Eğer  her model içinde kullanõlacaklarsa
bunlar Xsteel �System� dizini içine kopyalanabilirler. Örneğin;  C:\Xsteel\6.0\countries\euro\system  gibi.
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Dizi Dosyalarõ ve İkon Ayarlarõ

İkon Ayarlarõ

Xsteel�i kurarken bir Xsteel başlangõç ikonu oluşturulur ve bu ikon Windows masaüstüne yerleştirilir.
İkona ait �Start in� dizininin yukarõda Xsteel modellerinizi koyacağõnõz yeri işaret edip etmediğini kontrol
etmeniz õsrarla tavsiye edilir. Örneğin; Eğer modellerinizi C:\Xsteel_Models dizini altõna koyacaksanõz
ikona ait �Start in� dizininin bu dizini işaret ettiğinden emin olun. Burasõ Xsteel�in Xsteel rapor dosyalarõnõ
(Xsteel.log) ve diğer geçici dosyalarõ yerleştireceği dizindir.

Dikkat: İkona ait �Start in� dizinini kontrol etmek için ilk önce ikonu aktifleyin. Sonra fare sağ tuşuna çift
tõklayõp Properties�i seçin. Sonrada �Start in� alanõnõ gördüğünüz kõsa yol sayfasõna gidin.

Dizi Dosyasõ

Xsteel başlangõç dizi dosyalarõ istediğiniz standartlara uygun değişiklikleri yapmanõza imkan tanõyacak
bir çok ortam değişkeni içerir. Dizi dosyasõ (Xsteel_eng_euro.bat) C:\Xsteel\6.0\bat\ . altõnda olabilir.
Daha güncel bilgilere ulaşmak için ekran yardõmõna başvurun.

Dizi dosyasõ açõk ekranõnda zaman zaman değişikliğe ihtiyaç duyulan dizi �Runpath� dizisidir. Bu dizi bir
dosyanõn varlõğõnõ araştõrmak veya yeni bir model oluşturmak  için Xsteel�e önceden tanõmlanmõş bir
dizin tayin eder. Örneğin; farklõ projeler için farklõ dizi dosyalarõ oluşturmuş olabilirsiniz. Bu durumda
modelleri ayrõ tutmak için farklõ dizinleri işaret eden farklõ �Runpath� dizileri oluşturabilirsiniz.
Xsteel başlangõç dizi dosyalarõndaki �Runpath� dizisi aşağõdaki gibidir:

XS_ RUNPATH=c:\Xsteel_models gibi ayarlayõn.

Belirgin şekilde gösterilen aktiflenmiş kõsõm değişikliğin yapõlabileceği kõsmõ gösterir.

Dikkat: Dizi dosyasõnõ yazmanõn en kolay yolu masa üstündeki Xsteel ikonunu aktif hale getirip fare sağ
tuşuna basõp Edit�i seçmektir.
Bunun yanõnda Notepad veya Wordpad gibi metin yöneticileri kullanõlarak da açõlabilir.
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Profil, Malzeme ve Cõvata Veritabanlarõ
Xsteel dünyanõn değişik piyasalarõna uygun çok çeşitli yelpazede Profil , Malzeme ve Cõvata
veritabanlarõyla donatõlmõştõr. Önceden tanõmlõ veritabanlarõ hangi versiyonlarõ yüklediğinize bağlõdõr-
European, US, Imperial v.b.

Normalde bu standart veritabanlarõnda günlük çalõşmalarõnõzõ yürütmeye yetecek kadar bilgi vardõr, fakat
yeni profil, malzeme ve cõvatalarõn eklenmesi gereken durumlar olabilir.

Bu veritabanlarõna File çekme menüsünden girilebilir.
Bunun için File-Database-Profiles-Modify zincirini izleyin.

Çoğu zaman bu işlem gerekli kesit özelliklerini girip sonrada Add/OK tuşuna basmaktan ibarettir. Bu
işlemden sonra program bu veri tabanõnõn çalõşma dizininde mi yoksa (Working dõrectory) global
dizinde mi (Global directory) saklanmasõnõ istediğinizi sorar.  Working dõrectory; üzerinde hali hazõrda
çalõştõğõnõz modelin bulunduğu dizindir ve Global dõrectory�de veritabanlarõna ayrõlmõş bir �system�
dizinidir.( Örneğin; C:\Xsteel\6.0\countries\euro\profil\system gibi.)

Dikkat: Eğer bu yeni profili veya hazõrlayacağõnõz diğerlerini diğer modellerde de kullanmayõ
düşünüyorsanõz yenilenen veritabanõnõ Global dizine kaydedebilirsiniz.
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Otomatik kayõt � Aralõk Ayarlarõ ve Yenileme işlemleri v.b.

Zaman Aralõğõ Ayarlama

Otomatik kayõt için zaman aralõğõ  ayarõ Setup çekme menüsünden Autosave kullanõlarak yapõlabilir.
Numaralar komutlarõn menülerden kaç kere seçildiğini ifade eder. Örneğin modelde 30�a ayarlamak
demek �30 komuttan sonra otomatik kayõt işlemini gerçekleştir� anlamõna gelir.

Otomatik kayõt dosyasõnõ düzeltmek

Her Xsteel modeli aşağõdaki veritabanõ dosyalarõnõ barõndõrõr :
Model.db1 Kullanõmdaki veri tabanõ
Model.db1.bak Son kayõttaki veri tabanõ
Model.db1_user Otomatik kayõttaki son veri tabanõ
Model.db1_user.bak Otomatik kayõt öncesindeki veri tabanõ
Model.db2
Model.db2.bak
Model.db2_user
Model.db2_user.bak

Eşdeğer db1 dosyalarõna kõyasla Db2 dosyalarõ bazõ numaralandõrma bilgilerini içerir (her grupta en çok
kullanõlan sayõlar). Bu bilgi daha önce db1 dosyalarõnda muhafaza edilmekle birlikte, çoklu kullanõcõ
veritabanõna geçişle birlikte onlar da taşõndõlar.

Bu modeli açarken Xsteel otomatik olarak bir önceki modelin bozulup bozulmadõğõnõ anlar ve yine
otomatik olarak kaydedilmiş modelden mi devam etmek istediğinizi veya yeni bir modele mi başlamak
istediğinizi sorar.
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Xsteel başlangõcõ dizin dosyalarõ. Örnek: xsteel_eng_euro.bat

objects.inp dosyasõ � Bu dosya herhangi bir elemanõn özellikler
iletişim kutusunun �more� altõndaki değişkenler listesini kontrol
eder.
Xsteel Sembol dosyalarõ Örneğin: xsteel.sym

Önceden tanõmlõ  �system� veritabanõ dosyalarõ:
profdb.bin (Profil veritabanõ)
profcs.bin (Profil kesit veritabanõ)
matdb.bin (Malzeme veritabanõ)
screwdb.db (Cõvata veritabanõ)
assdb.db (Grup birleşim cõvata veritabanõ)

FLTPROPS dosyasõ � Bu dosya makrolarõn otomatik
kullanabileceği düz çubuk ebatlarõnõn mevcut bir listesini sunar.

Bu, kullanõlan versiyona ait  �system� dizinidir ve  �system� dizini
genelde şunlarõ içerir:

     - Çizim şablon dosyalarõ
     - Rapor şablon dosyalarõ
     - Çizim sunum dosyalarõ
- Yazõcõ veritabanõ (plotdev.bin)
- Kaydedilen düğüm noktasõ makro dosyalarõ
- Sihirbaz dosyalarõ
- standard.* dosyalar
- Ve önceden tanõmlõ değerler olarak kullanmayõ
istediğiniz ve kaydettiğiniz diğer çeşitli dosyalar.

�bin� dizini - xswrk.dat � Software kilidi izin şifresinin yazõldõğõ
dosya
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Dikkat :  Xsteel önceden tanõmlõ dizi dosyasõ ayarlarõ ile üzerinde çalõştõğõnõz model dizininde ilk ihtiyaç
duyacağõnõz dosyalarõ araştõrõr. Eğer gerekli dosyalar burada değilse, Xsteel bu dosyalarõ �system�
dizininde arar. (6.0 \ countries\ euro\profil or  6.0 \ countries\ euro\system)

Bu yüzden size tüm projelerde lazõm olacak önceden tanõmlõ dosyalarõ �system�dizinini yerleştirmenizi
ve projeye has özel dosyalarõ da bu projenin model dizinine yerleştirmenizi tavsiye ediyoruz.

Şablon dosyalarõnõ (rapor şablonlarõ ve çizim şablonlarõ) model dizinine yerleştirebilirsiniz fakat bu
tavsiye edilen bir şey değildir. Bu durum model dizininden bir dosyanõn eksilmesi anlamõna gelse de
çizimde tüm çizim şablonlarõnõn eksik olmasõ sonucunu doğurur. Aynõ durum, tüm modellerde,
sonrasõnda güncellenmeler gerektiren  başlõk blok�u v.s. gibi dosya değişikliklerinin ardõndan
sisteminizin güncellenmesini zorlaştõrõr. Fakat bu şablonlar �system�dizinine kaydedilmişse sadece bu
dizinin güncellenmesi yeterli olacaktõr.



                                                                                                                      

Xsteel Eğitim Kursu                                                                                                       Ders 15  �  Sistem Kişisel Ayarlarõ

Copyright Tekla Oyj 2000,  Computers & Engineering 2002  Tel: 0049 6406 73667   www.comp-engineering.com               Sayfa 15-12

CCCOOOMMMPPPUUUTTTEEERRRSSS   &&&
EEENNNGGGIIINNNEEEEEERRRIIINNNGGG

Xsteel Dizin Dosyalarõ Depolama Yapõsõ

Atamalarõn araştõrõldõğõ dizinleri tarif ederken  (iletişim kutularõndaki ayarlarõ yani standart dosyalar ,
kullanõcõnõn kaydettiği düğüm noktasõ, parçalar, çizimler v.s. özellikleri ) XS_PROJECT VE XS_FIRM
ortam değişkenlerini kullanabilirsiniz.

Bu değişkenleri kullanmanõn avantajõ Xsteel�i yeni bir versiyonuna yükselttiğinizde kişiselleştirdiğiniz
atamalarõ koruyabilmenizdir.

Yeni atamalarõ kaydettiğinizde bunlar her zaman model dizininde muhafaza edilir.

Fakat daha sona bunlar istenen yere taşõnabilir veya kopyalanabilirler. Mesela diğer projelerde de
kullanabilmek amacõyla proje dizinine taşõnabilir veya kopyalanabilir.

XS_PROJECT  değişkenini kullanabilmek için herhangi bir yerde el ile bir project klasörü oluşturun ve
sonra XS_PROJECT  değişkenini söz konusu bu klasörü işaret edecek şekilde ayarlayõn. Aşağõdaki
örneği inceleyin.

set XS_PROJECT=%XS_DIR%\countries\euro\project\



                                                                                                                      

Xsteel Eğitim Kursu                                                                                                       Ders 15  �  Sistem Kişisel Ayarlarõ

Copyright Tekla Oyj 2000,  Computers & Engineering 2002  Tel: 0049 6406 73667   www.comp-engineering.com               Sayfa 15-13

CCCOOOMMMPPPUUUTTTEEERRRSSS   &&&
EEENNNGGGIIINNNEEEEEERRRIIINNNGGG

Şimdi atamalar ilk önce kullanõmdaki model dizininde aranacaktõr ve sonra ortam değişkeleri tarafõndan
tanõmlanan dizinlerde... Aşağõdaki arama sõrasõnõ inceleyin :

1. Kullanõmdaki model dizinleri

2. XS_PROJECT

3. XS_FIRM

4. XS_SYSTEM

Eğer aranan dosya bulunursa arama işlemi bir üst seviyeye çõkmaz, bu yüzden farklõ dizinlerde farklõ
dosyalar mevcut ise bu arama sõrasõna göre en üst dizindeki dosya seçilir ve kullanõlõr. Eğer dosyalar
farklõ isimlere sahip iseler böyle bir durum yaşanmaz.

XS_PROJECT ve XS_FIRM ile tanõmlõ dizinlerden okunabilecek dosyalara ait daha geniş bir açõklama
için Xsteel yardõm dosyalarõna başvurunuz.

Şablonlar ve raporlar, XS_TEMPLATE_DIRECTORY ortam değişkeni ile tanõmlõ dizinlerde araşõrõlõr.
Bunlar dizinler içinde yukarõda anlatõlan araştõrma sõrasõna  göre araştõrõlõr, fakat arama işlemi  şablon
veya rapor dosyasõna rastlanan ilk dizinde durur ve diğer şablonlarõn da arama işlemi durdurulur.
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